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Using OfficeForms features
The following features are described:

The Designer environment
The Filler environment
Closing OfficeForms



The Designer environment
The Designer environment is used to construct your forms. When you start the Designer, you
will see the Designer screen.
This is the screen you use to design your forms. You can open any number of forms within 
the Designer at any time. Each will be shown in its own window, and you can select the form
you want from the list at the bottom of the Window menu.
Three toolbars hold the tools that you use to design your forms.
The right-hand area of the screen shows tutorial tips. This shows general information until 
you select a tool, when context-sensitive information relating to the use of that tool is 
displayed. You can use the buttons at the bottom to navigate through the tutorial tips.

The Designer screen
Designer toolbars
Changing the view of your form
Using tutorial tips



Designer screen
The following illustration shows the Designer screen. As you can move the toolbars around 
within the screen, your screen may look slightly different but all of the major features should
be present.
Click areas of the screen to see a description of what they do.



Main toolbar
This toolbar contains tools that affect form management.



Factory toolbar
This toolbar contains tools to create the elements that make up a form, and also to select 
the elements once they have been added to a form.



Format toolbar
This toolbar contains tools that control the appearance of text within the form.



Form design area
This area contains your actual form design. You can place, edit and move objects in this area
to create the layout of your form.



Tutorial tips area
This area contains tutorial tips related to the Designer screen. Clicking tools displays help 
relevant to that tool.



Status area
This area shows information about your form design. It contains:

The current cursor position.
The size of the current object.
The status of the Num Lock and Caps Lock keys
on your computer keyboard.

Title bar
This shows the name of your current form.



Window control buttons
These buttons control the size and status of the displayed window.



Screen control buttons
These buttons control the size and status of the screen.



Menu bar
This contains all of the menus that are available in this screen.



Designer toolbars
Three toolbars hold the tools you need to manipulate forms:

The Main toolbar contains tools that affect form management.
The Factory toolbar contains tools to create the elements that make up a 
form, and also to select the elements once they have been added to a form.
The Format toolbar contains tools that control the appearance of text within 
the form.

You can show or hide the toolbars individually, using options in the View menu. In the 
Windows 95/NT version of OfficeForms you can also position them as floating bars, or at the 
top or side of the dialog, by clicking within the toolbar and dragging it to the required 
position.

The Main toolbar
The Factory toolbar
The Format toolbar



Main toolbar
The following illustration shows the Main toolbar. Click the tools to see a description of what 
they do.



New tool
This opens a new blank form within the Designer. You can then begin a form design. This tool
is also available in the File menu.



Open tool
This allows you to load an existing form into the Designer. You then change the design, use 
the Test Fill facility or print your form. This tool is also available in the File menu.



Save tool
This allows you to save your work to disk. This tool is also available in the File menu.



Print tool
This allows you to print your form. This tool is also available in the File menu.



Print Preview tool
This displays a full page view of your form showing how it will appear when printed. This tool
is also available in the File menu.



Spelling tool
This allows you to perform a spellcheck on all of the text contained in your form. This tool is 
also available as the option Spellcheck on the Tools menu.



Cut tool
This allows you to remove the selected object(s) or text from the form and place them on 
the Clipboard. This tool is also available in the Edit menu.



Copy tool
This allows you to place the selected object(s) or text on the Clipboard without removing 
them from your form. This tool is also available in the Edit menu.



Paste tool
This copies the contents of the Clipboard into your form. This tool is also available in the Edit
menu.



Test Fill tool
This makes the Test Filler environment active, allowing you to test the filling properties of 
your form. This tool is available only when the Designer environment is currently operating.



Form Designer tool
This makes the Designer environment active. This tool is available only when the Test Filler 
environment is currently operating.



Bring to Front tool
This allows you to place the selected object (or objects) in front of any others in the form. 
This tool is also available in the Draw menu.



Send to Back tool
This allows you to place the selected object (or objects) behind any others in the form. This 
tool is also available in the Draw menu.



Align Objects tool
This allows you to line up the left-hand side of objects on your form. This tool is also 
available in the Draw menu.



Group tool
This allows you to form the selected objects into a single grouped object. This tool is 
available only when you have more than one object selected, and is also available in the 
Draw menu.



Group Radio Buttons tool
This allows you to form selected Checkbox objects into a group of Radio Button objects. This 
tool is available only when you have a number of Checkbox objects selected, and is also 
available in the Draw menu.



Ungroup tool
This allows you to disperse the selected group into its constituent objects. This tool is 
available only when you have a grouped object selected, and is also available in the Draw 
menu.



Show/Hide Math tool
This either displays or hides the Math tool to allow you to incorporate calculations into your 
form fields. This tool is also available in the View menu.



Show/Hide Factory tool
This allows you to decide whether you want to display the Factory toolbar. This tool is also 
available in the View menu.



Show/Hide Format tool
This allows you to decide whether you want to display the Format toolbar. This tool is also 
available in the View menu.



Zoom tool
This allows you to change the magnification used to view your form on the screen. This tool 
is also available in the View menu.



About tool
This allows you to view help information about the Designer environment. This tool is also 
available in the Help menu.



Factory toolbar
The following illustration shows the Factory toolbar. Only one tool can be selected at any 
time, and the selected tool is shown as pressed. Click the tools to see a description of what 
they do.



Selection tool
This allows you to select objects and groups within your form. Selected objects are shown 
with resizing handles.



Box tool
This allows you to create box objects within your form. You can click and drag to set the size 
and position of the box.



Line tool
This allows you to draw horizontal and vertical lines within your form. You can click and drag 
to set the size and position of the line.



Diagonal Line tool
This allows you to draw diagonal lines within your form. You can click and drag to set the size
and position of the line.



Ellipse tool
This allows you to draw diagonal ellipses and circles within your form. You can click and drag
to set the size and position of the ellipse.



Text tool
This allows you to draw text objects within your form. You can click and drag to set the size 
and position of the object, then type in the text.



Field tool
This allows you to draw field objects within your form. You can click and drag to set the size 
and position of the field.



Listbox tool
This allows you to draw listbox objects within your form. You can click and drag to set the 
size and position of the listbox.



Checkbox tool
This allows you to draw checkbox objects within your form. You can click and drag to set the 
size and position of the checkbox.



Action Button tool
This allows you to add a button to the form that will perform a number of actions when 
clicked.



Table tool
This allows you to place table objects within your form. A dialog will be displayed allowing 
you to enter details of the table.



Picture tool
This allows you to place graphics within your form. You can click and drag to set the size and
position of the object, then a dialog will be displayed allowing you to select the graphic to be
placed.



Barcode tool
This allows you to place barcodes within your form. You can click and drag to set the size 
and position of the barcode, then a dialog will be displayed allowing you to specify the 
barcode details.



OLE tool
This allows you to place embedded objects within your form. You can click and drag to set 
the size and position of the object, then a dialog will be displayed allowing you to specify the
object to be inserted. This tool is also available as Object (Insert menu).



Format toolbar
The following illustration shows the Format toolbar. Click the tools to see a description of 
what they do.



Typeface tool
This allows you to select the typeface you want for any selected text within your form. 
Typeface are shown in a drop-down list. In the Filler, you can change the typeface of text in 
memo fields.



Point Size tool
This allows you to choose the size of selected text within your form. Point sizes are shown in 
a drop-down list.



Bold tool
This allows you to make bold selected text within your form. This is a toggle tool.



Italic tool
This allows you to use the italic form for selected text. This is a toggle tool.



Underline tool
This allows you to underscore selected text within your form. This is a toggle tool.



Underline Word tool
This allows you to underscore selected words within your form (but not the spaces between 
them). This is a toggle tool.



Double Underline tool
This allows you to double underscore selected text within your form. This is a toggle tool.



Text Colour tool
This allows you to set the colour of selected text within your form. A colour palette will be 
displayed, from which you can select the required colour.



Text Alignment tool
This allows you to line up text within selected text objects. A dialog will be displayed 
allowing you to choose the alignment you want.



Text Rotation tool
This allows you to rotate selected text within your form. Common rotation angles are shown 
in a drop-down list, and you can either select one of these or type in any angle (to the 
nearest degree).



Shade tool
This allows you to set the background colour and pattern of selected objects within your 
form. A dialog will be displayed, from which you can select the required colour and pattern.



Line Style tool
This allows you to set the colour and pattern of the boundaries of selected objects within 
your form. A dialog will be displayed, from which you can select the required colour and 
pattern.



Shadows tool
This allows you to set the colour and style of shadow for selected objects within your form. A
dialog will be displayed, from which you can select the required colour and style.



Style tool
This allows you to choose a style for selected objects within your form. Styles for the object 
type are shown in a drop-down list.



Changing the view of your form
Within the Designer environment, you can change the way that your form is displayed. The 
View menu contains options that allow you to:

Display or hide each individual toolbar.
Display tutorial tips (shown on cue cards). You can move cue cards, but you 
cannot resize them.
Display rulers at the edges of the form and the status bar at the bottom.
Display the Math tool.

Zoom in or out on one portion of the form.
You can change the following by selecting Options (Tools menu):

Display or hide the outlines of checkboxes.
Show the baselines of objects containing text.
Show the margins at the edges of the form.

You can also use the normal Windows facilities to expand or contract the whole program 
frame.
If you have more than one form open within OfficeForms, each form is assigned to one or 
more window(s) which act as views onto the form. You can select the way that they are 
displayed using options in the Windows menu.



Using tutorial tips
You can display tutorial tips, giving context-sensitive information about OfficeForms screens 
and tools, within the Designer. These tips are shown in the right-hand area of the Designer 
screen, and change to reflect tools and selections.
To start or finish the display of tutorial tips, select Tutorial Tips (View menu).



The Filler environment
The Filler environment is used to enter data into your forms. When you start the Filler, you 
will see the Filler screen.
This is the screen you use to design your forms. You can open any number of forms within 
the Designer at any time. Each will be shown in its own window, and you can select the form
you want from the list at the bottom of the Window menu.
Note    If you have designed a form and you want to test its filling procedure, you do not need to use the 
Filler environment. You can use Test Fill (View menu), but you cannot save any entries you make during a
Test Fill operation.

Three toolbars hold the tools that you use to design your forms.
The Filler screen
Filler toolbars



Filler screen
The following illustration shows the Filler screen. As you can move the toolbars around within
the screen, your screen may look slightly different but all of the major features should be 
present.
Click areas of the screen to see a description of what they do.



Control toolbar
This toolbar contains the tools you need to navigate through and manipulate your form.



Text Format toolbar
This toolbar contains tools that control the appearance of text within the form when a memo
field is filled in.



Form area
This area contains the form to be filled. You can make your entries into form fields in this 
area.



Status area
This area shows information about the current form. It contains:

The current page in the form.
The status of the Num Lock and Caps Lock keys on your computer keyboard.

Filler toolbars
Three toolbars hold the tools you need to manipulate forms:

The Main toolbar contains tools that affect form management.
The Control toolbar contains the tools you need to navigate through and 
manipulate your form.
The Text Format toolbar contains tools that control the appearance of text 
within the form.

You can show or hide the toolbars individually, using options in the View menu. In the 
Windows 95/NT version of OfficeForms you can also position them as floating bars, or at the 
top or side of the dialog, by clicking within the toolbar and dragging it to the required 
position.

The Main toolbar
The Control toolbar
The Text Format toolbar



Main toolbar
The following illustration shows the Main toolbar. Click the tools to see a description of what 
they do.



Open tool
This allows you to load an existing form into the Filler. You then begin filling or print your 
form. This tool is also available in the File menu.



Send E-mail tool
This allows you to send the filled form directly to a remote e-mail address. This tool is also 
available in the File menu.



Import E-mail tool
This allows you to import form contents received by e-mail into the current form. This tool is 
also available in the File menu.



Save tool
Saves the typed-in information to a form data file.
If information has been typed in to a form and not yet saved, a dialog will appear for the 
data file name to be defined.    
If, however, the data has already been saved or if the form was invoked by opening a form 
data file, the updated contents are simply saved to the existing file.
See also : File Operations with Forms and Data.



Reload Contents tool
This reinitialises the fields on the form with the data that was last saved using the Save 
Contents tool.



Clear Contents tool
This resets all the fields on the form to their initial values.    This will be blank for text and 
date fields and zero for number fields unless particular initial values have been set up in the 
designer.



Control toolbar
The following illustration shows the Control toolbar. Click the tools to see a description of 
what they do.



Connections tool
This allows you to set up links from the Filler to external database applications. This tool is 
also available in the Database menu.



Add Mode tool
This sets the Filler so that you can make entries into the fields of the form. If the form is 
connected to a database, selecting this tool allows you to add records.



Browse Mode tool
This sets the filler so that you can view the objects but cannot make entries in fields.



Delete Record Tool
Deletes the currently displayed record from the database.



First Record tool
This allows you to move back to the first record in the set of records.



Skip Backwards tool
This allows you to move back several records in the set of records.



Prior Record tool
This allows you to move back to the previous record in the set of records.



Next Record tool
This allows you to move forward to the next record in the set of records.



Skip Forwards tool
This allows you to move forward several records in the set of records.



Last Record tool
This allows you to move forward to the last record in the set of records.



Sort Records Tool
Allows you to select a field to sort on.    The records are then presented in the requested 
order.



Filter tool
This allows you to specify criteria so that you can select a narrow range of records. This can 
be useful if you are trying to find a particular record within a sequence.



Setup Search tool
This allows you to enter search criteria to find a particular record within the current 
sequence.



Text Format toolbar
The following illustration shows the Text Format toolbar. Click the tools to see a description 
of what they do.



Closing OfficeForms
You can close the OfficeForms programs at any time. To do this, select Exit (File menu). If you
have any unsaved work, you will be asked if you want to save it before OfficeForms closes.
Note    If you are running Windows 95, you can close OfficeForms by clicking the Close button in the 
upper-right corner of the dialog.



The basics of form design and filling
The following are basic form design and filling operations:

Starting a new form
Designing a simple form
Closing a form
Printing and previewing a form
Opening an existing form
Saving a form
Filling in a form
Faxing a form



Starting a new form
Whenever you open OfficeForms, a new form is displayed for you to work on. You can also 
load a new, empty form at any time during an OfficeForms session.
To open a new form
Select the New tool from the Main toolbar. A new form will be opened automatically within 
OfficeForms.
Note    This form will be given a number. You must save it to give it a name.

You can now add objects as described in the topic Designing a simple form.



Opening an existing form
You can open any form at any time during an OfficeForms session.
To open an existing form
1 Select the Open tool from the Main toolbar. The standard Windows Open dialog will be 

displayed.
2 Select the form you want open, then click Open.
The selected form will open automatically. You can now modify the form using the 
techniques described in this manual.
Note    You can open as many forms as you want. Each will be shown in its own window.



Designing a simple form
Designing a form consists of placing objects on a page. These objects include lines, boxes, 
entry fields, checkboxes, listboxes, tables, pictures and text. You can also define how these 
objects will appear by setting shading and line parameters, and font details for text.
Simple form design consists of:

Placing objects onto the form page
Modifying objects
Entering text into fields
Moving objects
Deleting objects



Placing objects onto the form page
You can place any type of object in any position on your form using the Designer 
environment. You can then modify and/or move the objects to make the form look the way 
you want.
You can place objects of the following types:

Boxes
Angled lines
Text Objects
Listboxes
Tables
Barcodes
Horizontal and vertical lines
Ellipses
Fields
Checkboxes
Pictures
Embedded Objects

To place a box object on the form
1 Select the Box tool from the Factory toolbar.
2 Click and drag the outline for the object, in the position you want the box to appear on 

the form.



To draw a horizontal or vertical line on the form
1 Select the Line tool from the Factory toolbar.
2 Click and drag to draw the line where you want it to appear on the form.



To draw an angled line on the form
1 Select the Diagonal Line tool from the Factory toolbar.
2 Click and drag to draw the line where you want it to appear on the form.



To place an ellipse on the form
1 Select the Ellipse tool from the Factory toolbar.
2 Click and drag the outline for the object, in the position you want the ellipse to appear on 

the form.
If you want to place a circle on your form, you can do it using the Ellipse tool, making the length and 
width identical.



To place a Text Object on the form
1 Select the Text tool from the Factory toolbar.
2 Click and drag the outline for the object, in the position you want the text to appear on 

the form. The text outline will appear on the form, and the cursor will be shown at the 
beginning of the text area.

3 Type in the text that you want to appear within the Text Object.
Note    You must enter the text before you perform any other action in the Designer environment. If you 
click outside the Text Object, without entering text, the object will be removed from the form.

If the text you enter is larger than the size of the text object, the object will expand downwards to 
accept all of your text.



To place a Field on the form
1 Select the Field tool from the Factory toolbar.
2 Click and drag the outline for the field, in the position you want it to appear on the form.



To place a Listbox on the form
1 Select the Listbox tool from the Factory toolbar.
2 Click and drag the outline for the Listbox, in the position you want it to appear on the 

form.
The instructions for entering the options for a listbox are given in Setting up listboxes.



To place a Checkbox on the form
1 Select the Checkbox tool from the Factory toolbar.
2 Click and drag the outline for the Checkbox, in the position you want it to appear on the 

form.
Creating a set of radio buttons is described in To make radio buttons.



To place a Table on the form
1 Select the Table tool from the Factory toolbar. The Table Properties dialog will be 

displayed:
2 Enter the details of the table you want to insert, then click OK. The table will be displayed 

in the top left-hand corner of your form. You can then move it and resize it to meet your 
exact requirements.



Table Properties dialog
The following illustration shows the Table Properties dialog. Click areas of the dialog to see a 
description of what they do.



Name area
You can enter the name for your table object in this area.



Number of Columns area
You can enter the number of columns for your table in this area.



Number of Rows area
You can enter the number of rows for your table in this area.



Table style area
This area allows you to select one of the following table styles:

Table with headings for rows and columns.
Table with headings for rows but not for columns.
Table with headings for columns but not for rows.
Table with no headings for columns or rows.

OK button
Clicking this accepts all of your entries and selections, and closes the dialog.



Cancel button
Clicking this ignores all of your entries and selections, and closes the dialog.



Close dialog button
Clicking this closes the dialog.



To place a Picture on the form
1 Select the Picture tool from the Factory toolbar.
2 Click and drag the outline for the Picture, in the position you want it to appear on the 

form. The standard Windows Open dialog will be displayed.
3 Select the picture you want to place on the form then press RETURN.



To place a Barcode on the form
1 Select the Barcode tool from the Factory toolbar.
2 Click and drag the outline for the Barcode, in the position you want it to appear on the 

form. The Barcode Appearance dialog will be displayed:
3 Enter the details of the Barcode you want to insert, then click OK.



Barcode Appearance dialog
The following illustration shows the Barcode Appearance dialog with the Format tab 
selected. Click areas of the dialog to see a description of what they do.



Type list
This drop-down list shows all permissible types of barcode. You can select the type you want 
to use.



Orientation area
This area allows you to select one of the following barcode orientations:

Vertical running from top to bottom.
Horizontal running from left to right.
Table with headings for columns but not for rows.
Vertical running from bottom to top.
Horizontal running from right to left.

Value area
You can enter the numerical value for your barcode in this area.



Calculate Check Digit checkbox
Select this checkbox to include a check digit in your barcode.



Human Readable Text area
You can set the following readable text attributes in this area:

Whether any readable text will be shown with the barcode.
If readable text is shown, whether any check digit will be included.

Impose Nominal Size checkbox
Select this checkbox to make the barcode a fixed size, regardless of its normal size and 
properties.



Apply button
Click this to apply the attributes that have been set in this dialog. The barcode will show the 
attributes with the Barcode Appearance dialog still open, allowing you to modify your 
barcode interactively.



Text tab
Click this to show text attributes within the dialog.



Shading tab
Click this to show shading attributes within the dialog.



Barcode Appearance dialog
The following illustration shows the Barcode Appearance dialog with the Text tab selected. 
Click areas of the dialog to see a description of what they do.



Font list
You can select the text font from this list, which shows all of the fonts on your computer.



Colour list
You can select the text colour from this drop-down list.



Size list
You can select the text size from this list.



Font style area
You can select the style for the font. The following styles are available for most fonts:

Normal.
Bold.
Italic.
Bold and italic.

Underline checkbox
Select this to underscore the text.



Strikeout checkbox
Select this to strike out the text.



Format tab
Click this to show format attributes within the dialog.



Barcode Appearance dialog
The following illustration shows the Barcode Appearance dialog with the Shading tab 
selected. Click areas of the dialog to see a description of what they do.



Shade area
You can select the shading pattern for your object by clicking the square containing the 
pattern that you want.



Colour area
You can select the colour for your object by clicking the square containing the colour that 
you want.



Background area
The three buttons in this area allow you to choose the background colour that will show 
through the shading pattern. If you click the button labelled Other, a drop-down list will 
appear allowing you to choose the colour that you want.



To place an embedded object on the form
1 Select the OLE tool from the Factory toolbar.
2 Click and drag the outline for the Object, in the position you want it to appear on the 

form. The Insert Object dialog will be displayed.
3 Choose the type of object you want to place on the form, then click OK.



Insert Object dialog
The following illustration shows the Insert Object dialog for creating new objects. Click areas 
of the dialog to see a description of what they do.



Create New button
Select this if you want to insert an empty object. This will already be selected in this dialog.



Create from File button
Select this if you want to insert an object that already exists. The dialog will change to show 
file selection facilities.



Object Type area
This lists all of the file types that can be inserted. You can select a file type by clicking it in 
this list.



Display As Icon checkbox
Select this if you want the object to be represented by an icon in the form.



Result area
This area shows the type of object that will be inserted.



What's this? button
This allows you to view help on any part of the dialog. Click the button, then click the area 
for which you want to see help. A pop-up will appear showing details.



Insert Object dialog
The following illustration shows the Insert Object dialog for importing existing objects. Click 
areas of the dialog to see a description of what they do.



Create New button
Select this if you want to insert an empty object. The dialog will change to show a list of 
object types.



File area
This shows the name of the selected object. You can enter the name of any file, or select a 
file using the Browse button.



Browse button
Click this button to display a dialog allowing you to search for the object that you want to 
insert.



Link checkbox
Select this if you want to link the object to your form. If this checkbox is not selected, the 
object will be embedded in your form.



Create from File button
Select this if you want to insert an object that already exists. This will already be selected in 
this dialog.



Moving objects
When you have placed an object on a page of your form, you may need to move it to 
another position. You can do this at any time.

Moving objects using the mouse
Moving objects using the keyboard



To move an object using the mouse
1 Choose the Selection tool from the Factory toolbar.
2 Click within the outline of the object you want to move. The object will be selected.
3 Click again within the outline of the object and drag the object to its new position.
You can select and move a number of objects in one operation as described in Using multiple objects.



To move an object using the keyboard
1 Choose the Selection tool from the Factory toolbar.
2 Click within the outline of the object(s) you want to move. The object(s) will be selected.
3 Use the ARROW keys to move the selected object(s), which will move in steps of one grid 

space.
Note    If you have only one object selected, you can resize it by holding SHIFT and using the ARROW 
keys.



Modifying objects
You can change the size, shape, properties or appearance of an object at any time.
Note    You can apply an appearance style to an object. This is described in Using Styles.

The actual properties and appearance details that you can change depend on the type of 
object. You can:

Modify object size and shape
Change object line properties
Change text characteristics
Change object shading
Change object shadow properties



To modify an object size or shape
1 Choose the Selection tool from the Factory toolbar.
2 Select the object by clicking anywhere within its outline.
3 Click and drag the resizing handles to form the shape and size you want for the object.



To change object shading
1 Choose the Selection tool from the Factory toolbar.
2 Select the object by clicking anywhere within its outline.
3 Click the Shading tool from the Format toolbar. This will display a shading dialog.
4 Select the colours for the shading and the background. The object will change to reflect 

the changes.
5 When you are happy with the shading colours, click the OK button.



Shading dialog
The following illustration shows the shading dialog. Click areas of the dialog to see a 
description of what they do.



Background colour area
You can select the background colour from the drop-down list.



Demo area
This area shows the effect of clicking the OK button.



Demo area
This area shows the effect of clicking the Cancel button.



To change object line properties
1 Choose the Selection tool from the Factory toolbar.
2 Select the object by clicking anywhere within its outline.
3 Click the Line Style tool from the Format toolbar. This will display the Line Format dialog.
4 Select the colour and style for the lines that border the object. The object will change to 

reflect the changes.
5 When you are happy with the properties, click the OK button.



Line Format dialog
The following illustration shows the Line Format dialog. Click areas of the dialog to see a 
description of what they do.



Style area
You can choose the style of your lines from those displayed in this area.



Arrowheads area
You can select the style of arrowheads (if you want to use them) from those shown in this 
area.



Lines buttons
These buttons allow you to select the type of line.



Thickness list
You can select the line thickness you want from this drop-down list.



Demo area
This area shows how the selections in this dialog will make the object appear.



To change object shadow properties
1 Choose the Selection tool from the Factory toolbar.
2 Select the object by clicking anywhere within its outline.
3 Click the Shadow button from the Format toolbar. This will display the shadow dialog.
4 Select the colour and style for the shadow. The object will change to reflect the changes.
5 When you are happy with the shadow properties, click the OK button.
Note    If you want to change more than one property, e.g. shading and line, for an object, you can make 
the changes in the same visit to the Appearance dialog.



Shadow dialog
The following illustration shows the shadow dialog. Click areas of the dialog to see a 
description of what they do.



Shadow style area
You can select from five styles of shadow by clicking the buttons in this area.



Shadow colour area
You can select the colour for the shadow of your object by clicking the square containing the 
colour that you want.



To change text characteristics
1 Choose the Selection tool from the Factory toolbar.
2 Select either the text itself or the object containing the text.
3 Use the facilities on the Format toolbar to set the characteristics of the text, which will 

change to show the effect of each alteration you make. You can:
Make text bold and/or italic.
Apply any of three types of underline.
Change the colour of the text.
Change the alignment of the text within the object.
Rotate the text.

Note    When you change any of these characteristics, the changes will be applied to all of the text in the 
selected object. If you make alterations to the text within an object, for example changing or deleting 
characters, only selected text is affected.



Deleting objects
If you want to delete an object, you can either cut it from the form and place it on the 
clipboard or simply delete it.

Cutting an object
Deleting an object



To cut an object from your form
1 Choose the Selection tool from the Factory toolbar.
2 Select the object by clicking anywhere within its outline.
3 Select the Cut tool from the Main toolbar.



To delete an object from your form
1 Choose the Selection tool from the Factory toolbar.
2 Select the object by clicking anywhere within its outline.
3 Press the DELETE key on your keyboard.
Note    If you accidentally delete an object (or group of objects) that you wanted to keep, you can recover 
it by selecting Undelete (Edit menu).



Entering text into fields
You can enter text into:

Text Objects
Checkboxes
Table headings



Entering text into Text Objects
When you have drawn the outline of a Text Object, the cursor will appear within the box. You 
can type in the text directly. If the text is either too small or too large to fill the object, the 
object size will adjust automatically to the area occupied by the text. You can then format 
the text as described in To change text characteristics.
If you deselect a Text Object without typing any text within it, the object will be deleted from
your form. You cannot have a Text Object without text, even temporarily, as a this would be 
almost impossible to locate when not selected.



Entering text into Checkboxes
You can enter text into a Checkbox at any time after the Checkbox has been placed on your 
form. Double-click the Checkbox to place cursor within the box, then type in the text.



Entering text into table headings
To enter text into a table cell, select the table then double-click the cell. The cursor will 
appear in the cell. Type in the text that you want to enter.



Saving a form
You can save a form using either:

The current name
A new name



To save a form using its current name
To do this, simply select the Save tool while the form is open. Its current state will overwrite 
the last saved version of the form.
If you have not saved the form before, this will display the Save As dialog described in 
To save a form using a new name.



To save a form using a new name
1 Select Save As (File menu). The standard Windows Save As dialog will be displayed.
2 Select a folder (or directory path) for the form and enter its name, then click OK.
If you enter a name that already exists within the folder/directory, you will be asked to confirm that you 
want to overwrite the old form with that name.



Closing a form
You can close a form at any time during an OfficeForms session unless you are working with 
the Designer in Test Fill mode. If you are using Test Fill and you want to close the Designer, 
you must first click the Form Design tool from the Main toolbar.
To close a form
Select Close (File menu). If the form has changed since you last saved it, you will be asked if 
you want to save again before it is closed.



Filling in a form
There are two ways of filling a form:

Using the Test Fill facility
Using the Filler environment



Using the Test Fill facility
You can use the Test Fill facility to check that the fill characteristics are correct.
Note    You cannot save any entries you make using the Test Fill facility. It is simply intended as a quick 
check to try out the form without having to start the Filler.

To use the Test Fill facility
1 In the Designer environment, select Test Fill (View menu). The cursor will appear in the 

first field to be completed.
2 Type an entry for the first field, pressing RETURN if you want the entry to cover more than

one line.
3 Press the TAB key to move to the next field (or use the mouse to select the next field to 

be filled).
4 Repeat steps 2 and 3 until you have entered data into all the forms fields.
5 To close the Test Fill facility, select Design View (View menu).
Note    You cannot connect to a database in Test Fill. You can only do this using the Filler.



Using the Filler Environment
There are two different possible situations in the Filler Environment. They are:

Where a database is connected to the form.
Where the form is not accessing a database.

This section only deals with the second of these two situations. For details about using the 
filler with a database, see Using OfficeForms with databases.
When a form is first opened in the Filler, it is presented using the default connection. If no 
default connection has been defined, the form displays a dialog to allow the required 
connection to be chosen from a list.
Assuming the No Database Access has been chosen - either because it is the default 
connection or because it has been chosen from the dialog, the form toolbars will be 
modified.
Because there is no access to databases, one of the tools - the Control Toolbar, which 
controls access to the database - is not visible. 

Data that is typed in to a form may be saved in a form contents file.    
For details, see File Operations with Forms and Data. 

Navigating around your form
Cutting entries to the clipboard
Pasting entries from the clipboard
Changing the text colour
Filling fields in your form
Copying entries to the clipboard
Changing the format of text



File Operations with Forms and Data.
Overview
The form filler deals primarily with two different types of files - form files, which have an OFM
extension, and form data files which have an OFD extension.    
Form files are the forms you see presented on screen or output to a printer and into which 
information may be typed.
Form data files represent the information that is typed in to a form and then saved to disk.    
These files contain the data that was filled in on a form as well as the full path name of the 
form file that was filled.    By keeping the full name of the filled-in form, the filler is able to 
automatically open that form whenever the data file is opened.
File / Open Form command.
This command may invoked by selecting it from the File menu or by clicking the File Open 
button on the main toolbar.
It brings up a dialog which allows the required form to be selected or named directly.    When 
the form has been identified it will be brought into view in the filler.    There are three 
possible ways for the form to appear depending on the way the form was set up in the form 
designer:
1. The form may open linked to an untitled OFD file.
In other words, the form is not linked to a database.    In this case the form is ready to be 
filled in.    Once this has been done, its data can be saved using the Save Data command 
which will create a form data file.
2. The form may be open linked to a database.
In this case, the form will normally be in browse mode    which means that the records of the 
database appear one-by-one inside the form.
3. The form may have no default connection.
In this case a list of possible connections - including the one for no database access - will 
appear for the user to choose from.
File / Open Data command.
This command may invoked by selecting it from the File menu.
It brings up a dialog which allows the data file to be selected or named directly.    When the 
required file has been identified, the form that was originally used to save it is brought into 
view with the values from the data file already filled in.
File / Save Data command.
File / Save Data As command.
These commands are only available when the active form is not linked to a database.    If the 
form is linked to a database, the Save Data command is replaced with the Export Data 
command (see below).
The Save Data command may invoked by selecting it from the File menu or by clicking the 
Save button on the main toolbar.    The Save Data As command is always invoked by 
selecting it from the File menu.
The Save Data As command saves the data to an OFD file.    It always prompts for the name 
of the file before saving.    The Save Data command, on the other hand, only prompts for a 
name if there is not one already defined.    So if the data has already been saved, or if the 
form was initially opened by opening a form data file, the data will simply be saved to disk 
without prompting.
Export Data.



This command may invoked by selecting it from the File menu.    It is only available when the
active form is connected to a database, and its affect is to create a form data file based on 
the currently displayed record.
Insert / Form Data File command.
This allows data from a data file to be inserted into the current form.    The data file may or 
may not have been created with the form into which it is inserted.    If not, only the fields 
which have the same name as those in the original form will be affected.    A typical use for 
this command is to import common values from a file into a batch of new database records.



Clear values tool

The Clear Values tool, which initialises the fields on the form back to their default values. For
most fields this is blank or zero. The exceptions are:

Fields that have had an initial value specified in the designer.
Fields that have had a calculation specified in the designer.

Save values tool

Save Values, which saves the contents of all fields on the form. Any values already saved are
overwritten. The values are saved with the form itself. The exception is when the form is a 
program that has been created by the designer using the Save As Exe command. In this 
case the contents are saved to a file called <FormName>.ofx. When the form is closed, a 
message box will ask whether the field contents should be saved. If the answer is Yes - the 
contents will be saved as though this button had been pressed. 



Reload values tool

Reload Values, which reloads the contents of the form as last saved using the Save Values 
button.



To navigate around your form
Within the Filler environment, each form may have many pages. You can also have more 
than one occurrence of the form. In this case, each occurrence is called a record.
Tools on the Control toolbar allow you to:

Display the first or last record associated with the form.
Scroll backwards and forwards through the records associated with the form.
Move backwards and forwards through the pages of the current record.

You can use the scroll bars to move up and down through the current page.



To fill fields in your form
When you open a record, the focus will be placed in the first field to be filled. You can type 
the field entry directly using your computers keyboard. When you have entered data, press 
TAB to move to the next field. Fields will be filled in an order determined by the form 
designer.
To move the focus directly to a field, click within the field.
Some fields may have a restriction placed on the type of entry or the values that are 
allowed. If you enter a value that is not within the allowed type and range, an error message
will be displayed.



To cut an entry from your form onto the clipboard
1 Select the field containing the entry by clicking anywhere within its outline.
2 Select the Cut tool from the Main toolbar.
Note that only the text is cut from the form. The field is not removed.



To copy an entry from your form onto the clipboard
1 Select the field containing the entry by clicking anywhere within its outline.
2 Select the Copy tool from the Main toolbar.



To paste an entry from the clipboard onto your form
1 Select the field containing the entry by clicking anywhere within its outline.
2 Place the caret where you want the new information to appear.
3 Select the Paste tool from the Main toolbar.



To change the format of text
1 Select the text that you want to format.
2 Use the tools on the Text Format toolbar to set the typeface and point size. You can also 

make the text bold and/or italic, and you can underline with a single underline, double 
underline or underline words (but not the spaces between them).

Note    Text in fields that have not been set up as memo fields cannot be formatted using the Text Format 
toolbar.



To change text colour
1 Select the text to have its colour changed.
2 Click the Text Colour tool on the Text Format toolbar. A list will be displayed showing the 

colours that can be applied to text.
3 Select the colour you want.
Note    The colour will be applied only to selected text or to text typed in after you have selected the 
colour.



Printing and previewing a form
You can print the form at any time. If you want to see how the whole form looks before you 
print, you can preview the form.

  Printing a form
  Previewing a form



To print the form
Click the Print Direct tool from the Main toolbar. The form will be printed using the default 
printer for your computer.
If you want to select a different printer or to change the print options, select Print (File 
menu). This will display the standard Windows Print dialog allowing you to set up the print 
parameters before you print the form.



To preview the form
1 Select the Print Preview tool from the Main toolbar. The first page of the form will be 

displayed.
2 Using the command buttons on the toolbar at the top of the dialog, you can view any 

other pages of the form, and zoom in or out to examine details of the form.
3 If you want to print the form from the preview, click the Print command button. The Print 

dialog will be displayed and you can continue from step 2 of the procedure to print the 
form.



Manual
Please refer to the OfficeForms User Manual for information on this subject.



Faxing a form
You can fax a form from either the Designer or the Filler, allowing rapid transmission of both 
blank and completed forms. OfficeForms will use the standard fax interface for your 
computer (either a MAPI-compliant system or WinFax).
To fax a form
1 With the form open in the Designer, select Fax (File menu). This will display the Enter fax 

number dialog.
2 Enter the name and fax number of the person to receive the form. If the person is in your 

Windows address book, you can press RETURN to display the address book then choose 
the recipient.

3 Click OK. If this is the first fax you have sent from OfficeForms, you will be asked to 
choose a profile for the transmission; if you have faxed forms before, the existing profile 
will be used.

If your computer uses WinFax, it may take a few minutes to set up the transmission. A message box will
be displayed to confirm this, and you can cancel the transmission if you do not want to wait.

Note    The form may be configured so that the e-mail recipient and address are derived automatically 
from fields within the form. If this is the case, the e-mail will be sent automatically when you select the Fax
tool. For more information about automatic addressing of e-mails, refer to the examples given in 
Specifying calculations.



Enter fax number dialog
The following illustration shows the shading dialog. Click areas of the dialog to see a 
description of what they do.



Recipient's name area
Enter the name of the person who will receive the fax.



Recipient's fax number area
Enter the fax number of the person who will receive the fax.
If the person is in your Windows address book, you do not need to enter the number as OfficeForms 
will retrieve it automatically.



Streamlining form design
There are a number of ways that you can speed up the design of your forms, at the same 
time enhancing their appearance.

Using multiple objects
Aligning objects
Sending objects to the back or front
Using styles
Using the object library
Setting up different page layouts
Setting up fields
Using the alignment grid
Copying objects
Grouping and ungrouping objects
Using templates
Formatting text
Using action buttons



Using multiple objects
You can select any number of objects at one time. You can then manipulate the selected 
items as if they were a single object.

 Selecting multiple objects
 Setting properties for multiple objects



To select multiple objects
1 Choose the Selection tool from the Factory toolbar.
2 Select the first object by clicking anywhere within its outline.
3 Press and hold the SHIFT key on your keyboard.
4 Select the first object by clicking anywhere within its outline.
5 Repeat steps 3 and 4 until you have selected all of the objects you want.
If the objects are close together, with no other objects close to them, you can:
1 Choose the Selection tool from the Factory toolbar.
2 Click and drag an outline that includes all the required objects. All the objects that are 

totally enclosed by the outline will be selected.
You can now set the properties for these objects. If you move the selected objects, their 
relative positions will be maintained and they will be moved as a single object. You can also 
cut or copy the selected objects to the clipboard.
If you click anywhere outside the selected objects, all the objects will be deselected.



To set properties for multiple objects
If you have multiple objects selected, you can set properties for all of them in one action. 
The objects do not even have to be the same type. If any selected object does not possess 
the property you change, that object will remain unchanged.



Using the alignment grid
To simplify the alignment of objects as you move them around the form, you can set up a 
grid in the Designer environment. You can then choose whether you use the grid when 
positioning an object.

 Setting up the grid
 Making the grid active



To set up the grid
1 Select Grid Settings (Tools menu). This will display the Set Grid Spacings dialog.
2 Enter the spacings for your grid.
3 Click OK.



Set Grid Spacings dialog
The following illustration shows the Set Grid Spacings dialog. Click areas of the dialog to see 
a description of what they do.



Horizontal offset area
You can enter a starting point for the grid, measured from the left-hand edge of your form, in
this area.



Vertical offset area
You can enter a starting point for the grid, measured from the top edge of your form, in this 
area.



Horizontal spacing area
You can enter the horizontal spacing for your grid in this area (in inches).



Vertical spacing area
You can enter the vertical spacing for your grid in this area (in inches).



To make the grid active
To work with the grid on, simply select Snap To Grid (Draw menu). Any objects that you 
move will jump in steps of the size you set up for the grid, and new objects will lock onto the
grid as you create them.
We strongly recommend that you should set up and use a grid whenever possible, as it simplifies 
enormously the process of designing a form. The coarser the grid you use, the easier it is to position 
objects relative to each other.



Aligning objects
To make your form look fully professional, you will need to line up the objects that you have 
placed. OfficeForms makes this easy.
To align objects on your form
1 Using the Selection tool from the Factory toolbar, select the objects that you want to 

align.
2 Click the Align Objects tool from the Main toolbar. This will display the Align dialog.
3 Select the alignment parameters you want. Horizontal and vertical alignment are 

independent, and you can align objects with each other, the page margins or a fixed 
position on the form.

4 Click the OK command button.



Align dialog
The following illustration shows the Align dialog. Click areas of the dialog to see a description
of what they do.



Horizontal alignment buttons
You can choose the type of horizontal alignment for the selected object.



Vertical alignment buttons
You can choose the type of vertical alignment for the selected object.



Relative anchor buttons
You can select the item to which the object will be aligned, and its distance from the anchor 
item.



Copying objects
When you have placed an object on your form, you may want to add another that is either 
identical or very similar. Within OfficeForms you can copy an object as many times as you 
want, either by copying directly onto the form or using the clipboard.

 Copying an object directly
 Copying an object using the clipboard

Tip    If you want to copy an object or group of objects to a different form, copy using the clipboard.



To copy an object directly
1 Choose the Selection tool from the Factory toolbar.
2 Select the object by clicking anywhere within its outline.
3 Press and hold the CTRL key on your keyboard.
4 Keeping the CTRL key held down, click and drag the object to where you want the copy to 

appear.



To copy an object using the clipboard
1 Choose the Selection tool from the Factory toolbar.
2 Select the object by clicking anywhere within its outline.
3 Choose the Copy tool from the Main toolbar. This will place the object on the clipboard.
4 Choose the Paste tool from the Main toolbar. This will place a copy of the object in the top 

left-hand corner of the form window.
5 Click and drag the object to the position you want on the form.
Note    When you have pasted an object into your form from the clipboard, it will stay on the clipboard until
you replace it with something else. You can paste as many copies as you want into your form (or even 
into a different form).



Sending objects to the back or front
If two or more objects overlap, you can decide which appear at the front and back on the 
form.

 Sending objects to the back
 Bringing objects to the front



To send an object to the back
1 Using the Selection tool from the Factory toolbar, select the object that you want to send 

to the back.
2 Click the Send to Back tool from the Main toolbar.



To bring an object to the front
1 Using the Selection tool from the Factory toolbar, select the object that you want to send 

to the back.
2 Click the Bring to Front tool from the Main toolbar.



Grouping and ungrouping objects
You can form objects into groups that will behave as single items within OfficeForms. You can
even form groups that contain other, smaller subgroups.

 Grouping
 Ungrouping



Grouping
You can group any combination of objects to form a single object. You can then manipulate 
the group as a single object, setting the properties for the whole group at the same time.
The ability to group objects also allows you to convert a set of checkboxes into radio buttons
to represent a group of mutually exclusive options. The user will then be allowed to select 
only one option at a time. If an option is already selected, selecting a different option will 
replace the current selection. Options are shown as circles, with a black dot in the selected 
option.

 Grouping objects
 Selecting an item within a group
 Making radio buttons



To group objects
1 Select all the objects to be grouped (as described in the topic Selecting Multiple Objects).
2 Click the Group tool on the Main toolbar. The group will now show the outline of a single 

object
When you select a group, making a change to the appearance, for example changing the 
shading, will change the appearance of all of the objects in the group.
You can still select individual objects within a group, so that you can modify, move or delete 
any group component without affecting other group members.



To select an object within a group
1 Select the group containing the object.
2 Click within the object you want to select.
If the object you want to select is within a subgroup, you will need to select the subgroup before you 
select the individual object.



To make radio buttons
1 Place the required number of checkboxes on your form as described in To place a 

Checkbox on your form.
2 Align the checkboxes as described in the topic Aligning Objects.
3 Select the Group Radio Buttons tool from the Main toolbar. 



Ungrouping
Ungrouping converts the group into its constituent objects.
To ungroup objects
1 Select the group that you want to ungroup.
2 Select the Ungroup tool from the Main toolbar.
The process is hierarchical; if you had subgroups within the group, then ungrouping will still 
keep the subgroups. If you want to restore all subgroups to their individual objects, you will 
need to ungroup each of the subgroups.



Using styles
To make sure that the appearance of objects on your form is consistent, you can set up 
styles containing details of how an object will look. OfficeForms lets you build up a library of 
styles for each form that you can apply to any combination of objects. This gives you a quick
and easy way of producing professional forms.
You can set up styles for a range of object types.

  Object types
You can set up standard styles all text and fields within your form. To keep the appearance 
consistent, relatively few styles are needed for even the most complex forms. You can then 
change the appearance of your form quickly and easily by simply changing the styles.
For example, you may have 25 drop-down lists with the same style. If you want to apply a 
green shadow to these, you only need to make one change - to the style. All of the list boxes
will then change in one action. If you did not use a style, you would need to change each list 
box individually.

 Setting up a style library
 Applying a style to an object



Object types
You can set up styles for the following objects:

Action buttons.
Barcodes.
Checkboxes.
Ellipses.
Fields.
Lines.
Lines.
Tables.
Text Objects.

Setting up a style library
Using the OfficeForms style manager, you can enter as many styles as you want for each 
type of object. As you enter details of the style, you give it a name. This name will then be 
used to apply the style to objects on your form.
To enter a new style
1 Select Style Manager (Tools menu). This will display the Style Manager dialog.
2 Click the New button. This will display the Style Manager - New Style dialog.
3 Enter the name for the new style and select the type of object to which the style will 

apply.
4 Click the Next button. This will display the Style Properties dialog.
5 Set the object properties as you want them.
6 Click the Finish button. The style will be added to your style library for this form.



Style Manager dialog
The following illustration shows the Style Manager dialog. Click areas of the dialog to see a 
description of what they do.



Styles area
This area shows all of the styles defined in your Style Manager.



Edit button
Click this to edit the style selected in the Styles area. This will display the Style Properties 
dialog containing the properties of the selected style.



New button
Click this to add a new style to the list in the Styles area. This will display the Style Manager 
- New Style dialog.



Delete button
Click this to delete the selected item.



Copy button
Click this button to make a copy of the style under a different name. This will display the 
Style Manager - Copy Style dialog.



Style Manager - Copy Style dialog
The following illustration shows the Style Manager - Copy Style dialog. Click areas of the 
dialog to see a description of what they do.



Style based on area
This display-only area shows the object type and style that is to be used as the basis of the 
copy.



New style name area
Enter the name for the new style. This must be a unique name for that type of object.



Next button
Click this button when you are happy with the other entries in the dialog. This will display 
the Style Properties dialog.



Style Manager - New Style dialog
The following illustration shows the Style Manager - New Style screen. Click areas of the 
screen to see a description of what they do.



Object Type area
Select the object type for the new style, from the list.



Not available
This facility is not available in this dialog.



Style Properties dialog
The following illustration shows the Style Properties screen with the Text tab selected. Click 
areas of the screen to see a description of what they do.

The actual properties that are shown in this dialog depend on the object type.
  Object type details



Border tab
Click this to display the Border window within the Style Properties dialog.



Shading tab
Click this to display the Shading window within the Style Properties dialog.



Shadow tab
Click this to display the Shadow window within the Style Properties dialog.



Align tab
Click this to display the Align window within the Style Properties dialog.



Line spacing tab
Click this to display the Line spacing window within the Style Properties dialog.



Text tab
Click this to display the Text window within the Style Properties dialog.



Style Properties dialog
The following illustration shows the Style Properties screen with the Border tab selected. 
Click areas of the screen to see a description of what they do.

The actual properties that are shown in this dialog depend on the object type.
  Object type details



Colour area
You can click the colour that you want to use for your border from the palette.



Lines area
Select the type of line to be used for the borders. Options are:

None.
Single lines.
Double lines.

Rounded Corners checkbox
Select this if you want your border to have rounded corners. If this is unchecked, the borders
will have squared corners.



Style Properties dialog
The following illustration shows the Style Properties screen with the Shading tab selected. 
Click areas of the screen to see a description of what they do.

The actual properties that are shown in this dialog depend on the object type.
  Object type details



Transparent button
Click this if you want the form background to show through your objects.



Style Properties dialog
The following illustration shows the Style Properties screen with the Shadow tab selected. 
Click areas of the screen to see a description of what they do.

The actual properties that are shown in this dialog depend on the object type.
  Object type details



Style Properties dialog
The following illustration shows the Style Properties screen with the Align tab selected. Click 
areas of the screen to see a description of what they do.

The actual properties that are shown in this dialog depend on the object type.
  Object type details



Text Alignment area
You can choose the alignment and justification for your text by selecting one of these radio 
buttons



Style Properties dialog
The following illustration shows the Style Properties screen with the Line spacing tab 
selected. Click areas of the screen to see a description of what they do.

The actual properties that are shown in this dialog depend on the object type.
  Object type details



Height of tallest font button
Select this radio button to allow OfficeForms to set the line spacing to match the size of the 
largest font.



Fixed height button
Select this button to specify an exact height for lines of text. You must then enter the height 
in the Value area.



Value area
If you have selected the Fixed height radio button, enter the value of the line height in this 
area.



Presets area
You can select one of the preset line spacings by clicking one of these radio buttons.



Units area
You can set the units of the spacing value, either inches or centimetres, by selecting one of 
these radio buttons.



Finish button
Clicking this accepts all of your entries and selections, and closes the dialog.



Properties shown
The properties shown for each object type are:

For Boxes you can set details of border 
appearance, shading and shadow.
For Lines you can set details of border 
appearance, showing the colour and style of 
the line.
For Ellipses you can set details of border 
appearance, shading and shadow.
For Text objects you can set details of text 
format, alignment and line spacing.
For Fields you can set details of text format and
alignment, line spacing, border appearance, 
shading and shadow.
For Tables you can set details of text format 
and alignment, border appearance, shading 
and shadow.
For Pictures and Embedded objects you can set 
details of border appearance, shading and 
shadow.
For Barcodes you can set details of text format 
and shading.

Applying a style to an object
When you select an object, all of the styles you have designed for that object are available 
in the style library.
To apply a style
1 Select the object(s) to which you want to apply the style. Any style currently applied to 

the object will be shown in the Style tool at the right-hand end of the Format toolbar.
2 Click the arrow at the right of the Style tool to show a drop-down list containing all the 

styles from the library that you can use for that type of object.
3 Select the style that you want to apply to the object(s). The new style will be applied, and 

its name will be shown in the Style tool whenever the object is selected.



Using templates
OfficeForms allows you to save a form as a template so that you can use it as the basis for 
other forms in the future. This saves:

The page size, rotation (landscape or portrait) 
and margins.
All of the object styles in your current form.

When you apply the template to a different form, these are imported from the template. You 
can apply a template to a form at any time.

 Saving a form as a template
 Applying a template to a form



To save a form as a template
Note    When you save a form as template, the form itself and its objects are not saved in the template. 
Take care to save your form before you close it.

1 Select Save As Template (File menu). The Save As Template dialog will be displayed. This 
is a Windows Save As dialog allowing you to specify a file and destination.

2 Select a folder or directory for the template, and enter a name for it. Templates normally 
have the extension .OFL.

3 Click the Save button.



To apply a template to a form
1 Select Apply Template (File menu). This will display the Apply Template dialog allowing 

you to specify a file and location.
2 Select the folder/directory and template to be applied.
3 Click the Open button.
The current form will now take its page setup from the template. Styles defined in the 
template will also be imported into the current form. If styles in the form and template have 
the same type and name, the imported styles will replace those in the form. Any objects 
based on these styles will, of course, instantly change to reflect the newly imported styles.



Using the object library
If you often use identical or similar objects, you can speed up your form design by setting up
an object library containing your most common objects. You can then place these onto any 
form quickly and easily. You can also place object groups in your object library.

 Adding items to the library
 Deleting objects from the library
 Copying objects from the library onto forms



To add an item to the library
1 Select the object or group of objects on your form.
2 Select Object Library (Tools menu). This will display the OfficeForms Object Library dialog. 

The selected object is shown in the top left-hand box of the dialog.
3 Click the Add button. This will display the Object Name dialog.
4 Enter the name you want to use for the object, then click the OK button. The object will be

placed in the library section in the right-hand portion of the dialog. Its name will be shown
below its image, and will also be placed in the object list in the bottom left-hand box. The 
dialog will then close automatically.



OfficeForms Object Library dialog
The following illustration shows the OfficeForms Object Library dialog. Click areas of the 
dialog to see a description of what they do.



Add button
Click this to add an object to the library. This will display the Object Name dialog.



Copy to Form button
Click this to place the selected library object on the current form.



Close button
Click this button to close the dialog.



Objects in Library list
This list shows the names of all of the objects in the library. Selecting an object in this list 
displays it in the Objects in Library view area,



Objects in Library view
This area shows the name and appearance of every object in the library.



Selected object area
This area shows the appearance of the selected object.



Object Name dialog
The following illustration shows the Object Name dialog. Click areas of the dialog to see a 
description of what they do.



Name area
Enter the name of your library object here.



To delete an object from the library
1 Select Object Library (Tools menu). This will display the OfficeForms Object Library dialog.
2 Select the object you want to delete from the list in the bottom left-hand box.
3 Click the Delete button.
4 When you have deleted all the objects you no longer need, click the Close button to close 

the dialog.



To copy an object from the library onto a form
1 Select Object Library (Tools menu). This will display the OfficeForms Object Library dialog.
2 Either select the item you want to copy from the list in the bottom left-hand box or click 

the item in the preview box at the right-hand side of the dialog.
3 Click the Copy to Form button.
4 The dialog will close automatically and the selected item will be placed in the top left-

hand corner of the current page of your form.



Formatting text
The Format toolbar contains a number of tools that you can use to determine the 
appearance of text in your forms.
Tip    If you want to apply the same formatting to text in a number of objects, you may prefer to either 
group the objects or set up a style for the text.

You can change:
 Text format
 Text justification
 Text colour
 Text angle



To change text format
1 Select the text using the Selection tool from the Factory toolbar.
2 Use the tools on the Format toolbar to set the typeface and point size. You can also make 

the text bold and/or italic, and you can underline with a single underline, double underline
or underline words (but not the spaces between them).



To change the justification of text
1 Select the object containing the text.
2 Select the Text Alignment tool from the Format toolbar. This will display a list showing the 

alignments for text.
3 Select the alignment you want for the text.
Note    When you align text within an object, all of the text within the object is aligned to match your 
selection.



To change the colour of text
1 Select the object containing the text.
2 Select the text to have its colour changed.
3 Click the Text Colour tool on the Format toolbar. A list will be displayed showing the 

colours that can be applied to text.
4 Select the colour you want.
Note    The colour will be applied only to selected text. If you want to change the colour of all of the text in 
a text object, omit step 2.



To change the angle of text
1 Select the object containing the text.
2 Click the Text Rotation tool from the Format toolbar.
3 Enter the angle of rotation you want for the text, in whole degrees. The text will rotate 

counter-clockwise about its centre point.
Tip    A drop-down list attached to the Text Rotation tool shows recent entries together with increments of 
45o from 0o. If you want to use one of these, it may be quicker to select the angle you want from the list.



Setting up different page layouts
You can set up the size and orientation of your form, together with the margins that will be 
left free at the edges of the page. You can also add and remove pages.

 Setting up the page layout
 To add a page at the end of the form
 To add a page immediately after the current 

page
 To remove a page



To set up the page layout
1 Select Page Layout (File menu). The Page Setup dialog will be displayed.
2 Enter the details of the page you want for your form.
3 Click OK.
Note    Changing the Units selection does not change the units that are shown on the rulers in the 
Designer environment.

If your form has more than one page, you can add or remove pages.



Page Setup dialog
The following illustration shows the Page Setup dialog. Click areas of the dialog to see a 
description of what they do.



Paper Size list
Select the paper size for your form from this list. If you select Custom Size, you can enter 
your values in the Paper size areas.



Paper size areas
These show the width and height of the paper. If you have selected Custom Size from the 
list, you can enter the size values in these fields.



Paper orientation buttons
Select either Portrait or Landscape to determine the orientation of your form.



Margins area
You can enter values for the margin sizes of your form.



Units buttons
You can set the units of size values, either inches or centimetres, by selecting one of these 
radio buttons.



To add a page at the end of the form
Select Append Page (Edit menu).



To add a page immediately after the current page
Select Insert Page (Edit menu).



To remove a page
Select Delete Page (Edit menu). The current page will be deleted.



Using action buttons
An action button is a button that performs a predefined sequence of operations. You can 
place an action button anywhere on your form, and you can specify the operations that will 
be performed when the button is clicked.
Action buttons can greatly speed up and simplify form design if you have any operations 
that you need to perform regularly. By attaching these to an action button, one click can 
implement as many operations as you specify.

 Placing an action button on your form
 Specifying an action buttons operations



To place an action button on your form
1 Select the Action Button tool from the Factory toolbar.
2 Click and drag the outline of the button where you want it to appear on the form.
You can then select and move the button as required.



To specify an action buttons operations
1 With the cursor inside the area of the action button, click the right mouse button. This will

display a menu.
2 From the menu, select Button Actions. This will display the Action Button dialog:
3 In the Button Text area, enter the caption that you want to appear on the button.
4 To specify an action, click either the Add button (to include an action at the end of the list)

or the Insert button (to place an action immediately after the selected action). A list of all 
permissible actions will be displayed.

5 Select the action to be performed. You will be prompted to enter any further information 
needed to perform the action (for example e-mail address or fax number).

6 Repeat steps 4 and 5 until all of the operations to be performed have been specified.
7 If you want the button to be shown when the form is printed, select the Print Button 

checkbox.
8 Click the OK button.

  List of actions



List of actions
The following actions can be allocated to action buttons:
Action Result
Print Form This will print the current form.
Close Form This will close the form.
Initialise all fields This will set all of the fields in the form to their specified initial 

values (or blank if no initial value has been specified).
Validate all fields This will check that all field entries are within permitted limits.
Fax form to This will allow you to enter recipient details and fax the form.
Export form contents to This will allow you to export the form contents to a specified file.
Import form contents from This will allow you to select a form whose contents will be 

imported into the current form.
Email form to This will allow you to enter recipient details and e-mail the form.
Open form This will display a dialog box allowing you to select a form to be 

opened.
Set field value This will allow you to enter a value for the selected field.



Action Button dialog
The following illustration shows the Action Button dialog. Click areas of the dialog to see a 
description of what they do.



Button Text area
This area shows the text that will appear on the button. You can enter the label that you 
want.



Actions area
This area shows the actions that will be performed when the button is clicked. These actions 
are shown in the order in which they will be performed, with the first at the top of the list.



Print Button checkbox
Select this if you want the button to appear on hardcopy prints of the form.



Add button
Click this to insert an action at the bottom of the list in the Actions area. A list of all actions 
will be displayed, and you can select the one you want to insert.



Edit button
Click this to edit the parameters associated with the current selection in the list in the 
Actions area. If there are no parameters associated with the selection, this button is inactive.



Insert button
Click this to insert an action immediately above the current selection in the list in the Actions
area. A list of all actions will be displayed, and you can select the one you want to insert.



Delete button
Click this to remove the selected action from the list in the Actions area.



Move Up button
Click this to move the selected action up the list in the Actions area.



Move Down button
Click this to move the selected action down the list in the Actions area.



Setting up fields
At a simple level, setting up a field is a matter of selecting the field tool and, as described in 
The basics of form design and filling, drawing as many fields as required. The same can be 
said of listboxes and checkboxes. This bald description is true, but it misses out some 
essential details and subtleties.
A field is a complex object. It can be used, in the Filler, to represent different types of data 
including:

Text.
Memo data.

Memo data is like text but is capable of receiving different formatting characteristics, so the user may 
type in a mixture of fonts and character formatting into a field set up to hold memo data.

Numbers.
Dates.
Pictures.
Barcodes.
Logical values.

Logical values can be represented as a checkbox, a tickbox or a radio button.
Fields, listboxes and checkboxes
Selecting the field type
Number formatting
The Field data properties dialog
Setting formatting characteristics
Barcode formatting



Fields, listboxes and checkboxes
Fundamentally, a checkbox is just a field with a logical datatype. It is perfectly possible to 
convert any field into a checkbox by selecting this type in the Field data properties dialog. It 
is just as possible to go the other way and draw out a checkbox using the checkbox tool and 
then convert it, in the Field data properties dialog to have a completely different data type., 
a listbox is just a field which has the Act As Listbox property set. This causes the field to 
display as a listbox so that users can select the value from a list of possible values rather 
type in the value from scratch.
The reason for having separate checkbox and listbox tools on the toolbar is simply a matter 
of convenience. It is much easier to create a checkbox by selecting the tool and drawing it 
out than to draw out a field, invoke the Field data properties dialog, an set its datatype to 
checkbox (logical).



The Field data properties dialog
This dialog is the key to setting up the various different characteristics of a field (or 
checkbox, or listbox) which affect the way that the field behaves when it is filled in the Filler.
The part Preparing a Form for Filling deals with aspects of this such as setting validation, 
help and initial values for a field. This part of the manual outlines the way that the field can 
be made to represent different kinds of data, and how the presentation of the data can be 
controlled.



Selecting the field type
Selecting different types of data is controlled using the General window within the Field data 
properties dialog.
Each of the buttons with pictures in represent a different type of data. Reading from left to 
right we have:

Text.
Memo.
Numeric.
Date.
Pictures.
Barcodes.
Logical - checkbox, tickbox or radio button.

Additional controls on this page supply additional control over the way that the field will act 
in the Filler.

Protect From Data Entry.
This means that the user will be prohibited from
entering data directly in to the field. Select this,
for example, if the fields value is to be set only 
from a calculation, or if it is used to display a 
value in database record without allowing that 
value to be altered.
Mandatory Data Entry.
This means that, in the filler, the value must be 
supplied by the user before the form that 
contains it can be printed or saved to a 
database.

Note    Protect From Data Entry and Mandatory Data Entry are, of course mutually exclusive - you cannot 
set them both for the same field.

Save Field In Automatic Database.
When OfficeForms creates a database to hold 
information for a form, the usual thing is for it 
to create a column in the database for every 
field on the form. This will mean that the value 
of every field will be stored when a record is 
saved.
It is possible, however, that some fields are not 
required to be stored. In this case this control 
should be unchecked.
Act As Listbox.
This control is enabled when the data type has 
been set to Text, Memo, Number or Date. It is 
disabled (and set to false) for all other types. 
Setting it means that a list of values can be 
specified for the field. The field itself will be 
displayed with a button next to it which, in the 
filler, can be clicked to reveal these predefined 
values to choose from.



Setting formatting characteristics
Each field type has different formatting options. Therefore, different formatting pages will be
displayed in the Field data properties dialog for different data types.

Text Formatting.
There is no special formatting characteristics 
that may be specified for text.
Memo Formatting.
For memo fields, the option to allow different 
character formats and fonts to be mixed within 
the text may be enabled or disabled.
Number Formatting.
The number formatting page is quite complex. 
Its appearance varies substantially according to
the selection set up in the listbox between 
Accounting, Currency, Custom and Number. 
Date formatting.
Allows a choice of common date formats.
Picture Formatting.
There are no special formatting characteristics 
that may be specified for picture data.
Barcode Formatting.
Allows the type, orientation and other 
characteristics of the barcode to be set. See 
below for full explanation.
Checkbox formatting.
Allows a choice of checkbox, tickbox or radio 
button presentations.
Also allows the text to be placed either to the 
left or right of the checkbox.

Number formatting
You can format a number field by selecting the field then displaying the Format window in 
the Field data properties dialog.
The accounting, currency and number format choices are broadly similar. 
Accounting and currency allow specification of:

Whether to include the currency symbol to be 
included.
Number of decimal places.
Accounting leaves a gap between the currency 
symbol and the number itself. Currency 
additionally allows a format for negative 
numbers to be specified.

Number allows specification of:
Number of decimal places.
Negative number format.
Whether to use the thousands separator.

The Custom number format option is much more sophisticated:



A separate specification is allowed for each of positive numbers, negative numbers and zero.
The specification consists of:

Option to use the thousands separator.
Option to pre-scale the number by 100.
This is used in percentages where, for example,
a value of .1 is displayed as 10 (as in 10 
percent).
A text colour.
A mask.

 Understanding the mask



Field data properties dialog
The following illustration shows the Custom number format option in the Field data 
properties dialog. Click areas of the dialog to see a description of what they do.



Sample area
This area shows how the selections will affect the appearance of numbers.



Positive number format area
In this area you can specify the format of positive numbers. You can set up:

Whether to use the thousands separator.
Whether numbers will be shown as 
percentages.
The text colour for the numbers.

Negative number format area
Whether to use the thousands separator.
Whether numbers will be shown as 
percentages.
The text colour for the numbers.

Zero number format area
Whether to use the thousands separator.
Whether numbers will be shown as 
percentages.
The text colour for the numbers.

Number type selection area
You can select the type of number to be formatted from the list in this area.



Understanding the mask
A mask consists of text that may include:

The # symbol.
The 0 symbol.
The decimal point symbol ( . ).
Quoted text - e.g. - Pounds
This causes the text to appear in the number.
An underscore (_) followed by another 
character.
An asterisk (*) followed by another character.
There may only be one of these in the mask.

To understand how to use the mask you need to understand how it is processed, together 
with the number, to arrive at the number to display.
To the left of the decimal point, counting only the 0 and # characters in the mask 
(everything else is considered to have zero length) :
If the mask is shorter than the number, it is padded to the left with # characters to be equal 
to the number of digits preceding the decimal point. Any mask characters preceding the 
unexpanded mask are left preceding the mask when it has been expanded.
If the number is shorter than the mask, it is padded to the left with leading zeros to be equal
to the number of # and 0 characters preceding the decimal point.
To the right of the decimal point a similar padding action occurs.

  Processing numbers before the decimal point
  Processing numbers after the decimal point



Processing numbers before the decimal point
Each leading zero digit is either displayed or 
discarded depending on whether the 
corresponding mask character is a 0 or a # 
respectively.
If Use Thousands Separator is specified, the 
thousands separator (normally a comma) is 
inserted at the appropriate points.
Any quoted text is inserted in the display as it 
is encountered in the mask. Similarly, an 
underscore followed by a character is replaced 
by a space of the same width as the character.
The decimal point is displayed if it is specified 
in the mask.

Processing numbers after the decimal point
For each in 0 character in the mask following 
the decimal point, a number is displayed - 
including a trailing zero.
For each # in the mask, a number is displayed 
if, and only if, it is not a trailing zero.
After all other processing of the mask has been 
completed, if there is an asterisk followed by a 
character, the display is padded with that 
character to fit the available space.

Barcode formatting
You can format a barcode field by selecting the field then displaying the Format window in 
the Field data properties dialog.
Options may be set for:

Barcode type.
This is the fundamental encoding format to be 
used for the barcode and will depend on its 
intended application.
Orientation.
Choose one of 4 possibilities.
Calculate check digit.
If the barcode type requires a check digit, this 
will cause it to be calculated automatically by 
the system. Otherwise the users input must 
include the check digit.
Human Readable Text.
Often, a barcode is printed including the text 
upon which it is based. Select the Display 
checkbox to enable this.
Check Include Check Digit to include this in the 
displayed text.
Impose nominal size.



Some barcode types have a nominal or 
recommended size for which the barcode is 
designed. If this is checked, the barcode field 
may not be resized to any other dimension.

Field data properties dialog
The following illustration shows the Barcode format option in the Field data properties dialog.
Click areas of the dialog to see a description of what they do.



Preparing a form for filling
The following can be done to prepare your form for filling:

Customising the filling order
Setting up listboxes
Setting up standard phrases
Specifying calculations
Fixing the input format
Setting filling properties
Specifying initial values
Setting up validation
Setting up context sensitive help



Customising the filling order
By default, the OfficeForms will fill the fields working from left to right then stepping down to
the next row and repeating. Sometimes, for example if name and address fields are placed 
one below the other, it would be better to fill the fields in a different order.
OfficeForms allows you to decide the order in which fields will be presented for filling.

 Changing the filling order
 Restoring the default filling order



To change the filling order
1 Select Change Filling Order (Tools menu). This will display the Filling Order dialog.
2 Select the fields on your form in the Designer in the order that you want them to be filled.

The order will be shown in the Order area of the Filling Order dialog.
3 If you want to replace the first field to be filled, select the field you want to be first then 

click the Move to top button. You will be asked to confirm the change.
4 If you want to ignore all changes made in this occurrence of the dialog, click the Undo 

Changes button. The original filling order will be shown in the Order area.
5 If you use the UP and DOWN arrow keys to move through the list, the fields on your form 

will be highlighted. You can use this to check that the filling order is as you want it.



Filling Order dialog
The following illustration shows the Filling Order dialog. Click areas of the dialog to see a 
description of what they do.



Order area
This area shows the fields in the order in which they will be filled. You can select fields by 
clicking them or by using the UP and DOWN arrow buttons.



Move to top button
Click this to move the selected field in the Order area to the top of the filling list. This field 
will then be filled first.



Set Natural Order button
Click this to set the filling order to its default sequence. This presents fields for filling in the 
same order as they were placed on the form.



Undo Changes button
Click this to ignore all changes made in this occurrence of the dialog. The original filling 
order will be shown in the Order area.



To restore the default filling order
If you have changed the filling order, but you now want to return to the default filling order, 
click the Set Natural Order button.



Setting filling properties
You can set up the properties of fields within your form that affect their behaviour in the 
Filler.
To set general features
1 Select the field that you want to set up
2 Select Data Properties (Edit menu). Note that this option is also present on the menu 

displayed when you click the right mouse button. This will display the Field data 
properties dialog.

3 Enter the field name (if required).
4 Select the type of entry that the user will be able to make in the field using the seven 

buttons. Field types are text, memo, numeric, date, picture, barcode and checkbox.
5 Select the checkboxes that set the behaviour of the field.



Setting up listboxes
When you use the Listbox tool to place a Listbox object on your form, the listbox does not 
contain the options that will be shown for selection. You can enter the options you want to 
be presented.

Setting up listbox options
Inserting options
Changing list values
Specifying initial values
Moving options in the list
Removing options from the list



To set up listbox options
1 Select the Listbox that you want to set up
2 Select Data Properties (Edit menu). Note that this option is also present on the menu 

displayed when you click the right mouse button. This will display the Field data 
properties dialog.

3 Click the Values tab to display the Values window in the dialog:
4 Click the Add button. The cursor will be placed in the text entry field.
5 Type in the list entries, pressing RETURN after each. The entries will be presented in the 

list in the order in which you enter them.
6 If you want to allow clients to enter values that are not present in the list, select the 

Permit Values Not In List checkbox. If you do not want to allow this facility, deselect the 
checkbox.

7 Click OK to close the dialog



Field data properties dialog
The following illustration shows the Field data properties dialog with the General tab 
selected. Click areas of the dialog to see a description of what they do.



Field Name area
This area shows the name of the current field. You cannot change the entry in this field.



Text button
Click this to make the field a text field. When the form is filled, the user will be able to enter 
text into the field.



Memo button
Click this to make the field a text field. When the form is filled, the user will be able to enter 
memo data into the field.



Number button
Click this to make the field a text field. When the form is filled, the user will be able to enter 
numerical values into the field.



Date button
Click this to make the field a text field. When the form is filled, the user will be able to enter 
a date in the field.



Picture button
Click this to make the field a text field. When the form is filled, the user will be able to place 
a picture in the field.



Barcode button
Click this to make the field a barcode field. When the form is filled, the user will be able to 
set the barcode that will appear in the field.



Checkbox button
Click this to make the field a checkbox field. When the form is filled, the user will be able to 
select or deselect the checkbox.



Protect From Data Entry checkbox
Select this to prevent users from making entries into this field when the form is filled.



Mandatory Data Entry checkbox
Select this to ensure that the user must make an entry in this field when the form is filled.



Save Field Data in Automatic Database checkbox
Select this to allow entries made in the field to be passed to a database. Note that you must 
also link the form to the database.



Act As Listbox checkbox
Select this to make the field a listbox.



Validation tab
Click this to display the Validation window within the Field data properties dialog.



Help tab
Click this to display the Help window within the Field data properties dialog.



Values tab
Click this to display the Values window within the Field data properties dialog.



Format tab
The window that will be shown when you select this tab depends on the type of field you 
have selected in your form.

 Fields that can contain text
 Fields that can contain numbers
 Fields that can contain barcodes



General tab
Click this to display the General window within the Field data properties dialog.



Appearance button
Click this to set up the appearance of the object. The Object Appearance dialog will be 
displayed.



Object Appearance dialog
The following illustration shows the Object Appearance dialog with the Text tab selected. 
Click areas of the dialog to see a description of what they do.



Text tab
Click this to display the Text window within the Object Appearance dialog.



Border tab
Click this to display the Border window within the Object Appearance dialog.



Shading tab
Click this to display the Shading window within the Object Appearance dialog.



Shadow tab
Click this to display the Shadow window within the Object Appearance dialog.



Align tab
Click this to display the Align window within the Object Appearance dialog.



Data button
Click this to display the Field data properties dialog.



Line spacing tab
Click this to display the Line spacing window within the Object Appearance dialog.



Object Appearance dialog
The following illustration shows the Object Appearance dialog with the Border tab selected. 
Click areas of the dialog to see a description of what they do.



Object Appearance dialog
The following illustration shows the Object Appearance dialog with the Shading tab selected.
Click areas of the dialog to see a description of what they do.



Object Appearance dialog
The following illustration shows the Object Appearance dialog with the Shadow tab selected. 
Click areas of the dialog to see a description of what they do.



Object Appearance dialog
The following illustration shows the Object Appearance dialog with the Align tab selected. 
Click areas of the dialog to see a description of what they do.



Object Appearance dialog
The following illustration shows the Object Appearance dialog with the Line spacing tab 
selected. Click areas of the dialog to see a description of what they do.



Field data properties dialog
The following illustration shows the Field data properties dialog with the Validation tab 
selected. Click areas of the dialog to see a description of what they do.



Expression list
Select the expression that you want to apply, from the drop-down list.



NOT checkbox
Select this to invert the expression (e.g. to convert greater than into not greater than).



Limits area
Enter the expression limit values into these areas. If only one limit is required for the 
expression, then only the top area will be available for entry of a value.



No Validation button
Click this if you want to remove all input validation from the field.



Field data properties dialog
The following illustration shows the Field data properties dialog with the Help tab selected. 
Click areas of the dialog to see a description of what they do.



Context Sensitive Help area
You can enter any text that you want to append as context sensitive help for the field.



Field data properties dialog
The following illustration shows the Field data properties dialog with the Values tab selected. 
Click areas of the dialog to see a description of what they do.



Listbox Data list
This shows the list of options that will be present in the drop-down list. You can enter new 
options in the top area by selecting either the Insert or Add button.



Add button
Click this to add a new option at the bottom of the list in the Listbox Data area.



Insert button
Click this to add a new option immediately above the selected option in the Listbox Data 
area.



Move Up button
Click this to move the selected option up one place in the list.



Move Down button
Click this to move the selected option down one place in the list.



Edit button
Click this button to edit the parameters associated with the selected option.



Permit Values Not In List checkbox
Select this if you want to allow users to enter values that are not present in the predefined 
list.



Clear button
Click this to delete the entry in the Initial Value area.



Initial Value area
You can enter an initial value here to appear as the default in the listbox.



Field data properties dialog
The following illustration shows the Field data properties dialog with the Format tab selected.
Click areas of the dialog to see a description of what they do.



Allow format changes checkbox
Select this to allow the user to reformat entries as the form is filled.



To specify an initial value
To set the value that will appear by default in the list, enter the required value in the Initial 
Value area of the Values window. You can remove the contents of this area by clicking the 
Clear button.



To insert an option
1 In the Listbox Data area of the Values window, select the option above which you want to 

add the new option.
2 Click the Insert button. The cursor will be placed in the text entry field.
3 Type in the new entry, and press RETURN.



To move an option in the list
1 In the Listbox Data area of the Values window, select the option that you want to move.
2 Click the Move Up and Move Down buttons to move the option to the correct position in 

the list.



To change a list value
1 In the Values window, select the option.
2 Click the Edit button. The value will be placed in the text entry field.
3 Make the required changes then press RETURN.



To remove an option from the list
1 In the Values window, select the option.
2 Click the Delete button.



Setting up standard phrases
If you have phrases that you use regularly to allow clients to fill in your forms, you can enter 
them into a phrase library. This will speed up form filling. You can also give each phrase its 
own shortcut key combination. The phrase will then be printed on your form whenever you 
enter that key combination in the Filler environment.
Note    You can also use phrases from the library when typing text in the Designer.

Using the phrase library consists of:
 Entering phrases into the phrase library
 Editing phrases
 Making copies of phrases
 Placing phrases on forms



To enter a phrase into the phrase library
1 Select Phrase Library (Tools menu). This will display the Phrases dialog.
2 Click the New button. This will display the Modify Phrase dialog.
3 Enter a name, the phrase and any shortcut key combination.
4 Click OK. This will again display the Phrases dialog, with the name of your new phrase 

shown in the list area.



Phrases dialog
The following illustration shows the Phrases dialog. Click areas of the dialog to see a 
description of what they do.



Phrase area
This area contains a list of all of the phrases in the phrase library.



Edit button
Click this to edit the selected phrase. This will display the Modify Phrase dialog containing 
the selected phrase.



Copy button
Click this to make a copy of the selected phrase. This will display the Modify Phrase dialog 
containing the selected phrase, and you can enter a name and shortcut key combination for 
the copy.



New button
Click this to enter a new phrase into the phrase library. This will display a blank Modify 
Phrase dialog so that you can enter details of the new phrase.



Delete button
Click this to remove the selected phrase from the phrase library. You will be asked to confirm
the deletion.



Modify Phrase dialog
The following illustration shows the Modify Phrase dialog. Click areas of the dialog to see a 
description of what they do.



Name area
This area shows the name of the phrase within the phrase library.



Phrase area
This area shows the full phrase. If you want the phrase to occupy more than one line, press 
CTRL + RETURN at the end of each line.



Key area
You can specify a shortcut key combination by entering an alphanumeric key in the Key area 
then selecting checkboxes to give a combination of CTRL, ALT and SHIFT keys.



To edit a phrase
1 Display the Phrases dialog and select the phrase.
2 Click the Edit button. This will display the Modify Phrase dialog with the selected phrase.
3 Make any changes you want then click OK.



To make a copy of a phrase
1 Display the Phrases dialog and select the phrase.
2 Click the Copy button. This will display the Modify Phrase dialog with the selected phrase 

but no phrase name.
3 Enter the new name and make the changes you want, then click the OK button.
Note    Any shortcut key combination associated with the original phrase cannot be used with the copy; if 
you want to use shortcut keys, each phrase must have a unique combination.



To place a standard phrase on a form
1 Open the form in the Filler environment.
2 Select the field in which you want to place the phrase.
3 Select Insert Phrase (Text menu). This will display the Insert Phrase dialog containing all of

the phrases in the library for the form.
4 Select the phrase you want then click OK.
If the phrase has a shortcut key combination, you can enter that combination after step 2 and the 
phrase will be entered in the field directly.



Insert Phrase dialog
The following illustration shows the Insert Phrase dialog. Click areas of the dialog to see a 
description of what they do.



Phrase list
This area list the phrases in the library and shows their shortcut key combinations.



Specifying initial values
You can set up an initial value that will appear in a field of your form when it is opened in the
Filler. The user can then change this, or just accept the default value.
To set up an initial value
1 Select the Field that you want to set up
2 Select Data Properties (Edit menu). Note that this option is also present on the menu 

displayed when you click the right mouse button. This will display the Field data 
properties dialog.

3 Click the Values tab to display the Values window in the dialog.
4 Click in the Initial Value area. The cursor will appear in the area.
5 Type in the initial value for the field. Note that clicking the Clear button will empty the 

Initial Value area.
6 Click OK to close the dialog.



Specifying calculations
You can set up calculations that will be used to fill fields within your form. These entries will 
then be made automatically as the client fills in the form.
If you are specifying calculations for a table, you can apply the same calculation to all rows. 
This allows you to have a results column, showing the calculation result for each individual 
row.
A general procedure for calculation specification is given here, together with two examples 
to show how the facility can be used in your forms.

 Specifying a calculation
 Example 1 - to sum a group of fields

Example 2 - to introduce a total column into a 
table
Example 3 - to include an e-mail or fax address



To specify a calculation
1 Select the Math tool from the Main toolbar. This will display the Mathtool dialog.
2 Select the field to which the calculation will apply.
3 Click in the Mathtool dialog text entry field. This will display the expanded Mathtool 

dialog.
4 Specify the calculation that you want to apply. To include the contents of another field in 

the calculation, click within that field. You can enter any combination of field contents, 
functions and mathematical operators, but you cannot end the expression with an 
operator. You can also use the Copy and Paste buttons to duplicate strings and operations 
within the Mathtool dialog.

5 If you want to apply the calculation to a table column, click the Fill Down button. This will 
apply a similar calculation to all rows below the current row. If you have included fields 
within the current row, the corresponding field will be used in each row.

6 Click the OK button.
If you want to delete a whole calculation, click the Eraser button.



Mathtool dialog
The following illustration shows the Mathtool dialog. Click areas of the dialog to see a 
description of what they do.



Fill Down button
Click this to apply a similar calculation to the following cells within the column of a table.



Address button
Click this to use the field as the source for an e-mail or fax address. This will display the 
Select Special Field to Calculate dialog.



Calculation area
This area shows the calculation that will be applied to derive the content of the field.



Expand button
Click this to display the expanded Mathtool dialog.



Expanded Mathtool dialog
The following illustration shows the Mathtool dialog. Click areas of the dialog to see a 
description of what they do.



Keypad
You can click the buttons on the keypad to make entries in the calculation area.



Eraser button
Click this to delete the contents of the calculation area.



Functions button
Click this to display a list of functions that you can use in your calculations. You can then 
select a function to place the calculation area.



Sum button
Click this to place a SUM( ) function in the calculation area. You can then enter the items to 
be summed.



Example 1 - to sum a group of fields

To make the right-hand field (field 4) show the sum of three other fields (fields 1 to 3) in the 
form, simply open the Math tool then select the right-hand field. Hold down the SHIFT key on
your keyboard and click in each of the other three fields. The calculator will show the names 
of the fields:

Click the OK button.
When a user enters numbers into the three fields, the sum of these numbers will be shown 
automatically in the fourth field.



Example 2 - to introduce a total column into a table

To make the right-hand column automatically reflect the contents of the other two columns, 
open the Math tool then select the right-hand cell in row 1 of the table. Click in the left-hand 
cell in row 1, then click the + button the Math tool. Click in the middle cell in row 1. The 
Math tool now shows:

Click the Fill Down button, then the OK button.
When a user enters numbers into the Quantity and Price per item cells in any row, the 
product of these numbers will be shown automatically in the Total cost cell of the row.



Example 3 - to include an e-mail or fax address
You can use the Math tool to set up automatic generation of recipients and addresses for e-
mail and form faxing. Whenever the form is e-mailed or faxed from the Filler, it will then be 
sent to this recipient and address.
To specify any of these, select the field that will be used as the data source in the completed
form then open the Mathtool dialog. Click the Address button to display the Select Special 
Field to Calculate dialog.
Select the item that the field will represent, then click the Continue button. The expanded 
Math tool dialog will be displayed showing that the field has been assigned.



Select Special Field to Calculate dialog
The following illustration shows the Select Special Field to Calculate dialog. Click areas of the
dialog to see a description of what they do.



Field type area
This area shows the special field types that area available.



Continue button
Click this to set the field to the selected special field type.



Setting up validation
You can set up validation for fields within your form, so that entries are checked as they are 
made. If an invalid entry is made as the form is filled, an error message will be displayed.
To set up validation for a field
1 Select the field to which you want to apply validation.
2 Select Data Properties (Edit menu). This option is also available on the menu displayed 

when you click the right mouse button. This will display the Field data properties dialog.
3 Click the Validation tab to display the Validation window in the dialog.
4 Select the type of validation and its value, setting the NOT checkbox if required (for 

example to convert greater than to NOT greater than).
5 Click the OK button.
If you want to remove all validation from a field, click the No Validation button in the Validation 
window.



Setting up context sensitive help
You can enter help information for the field. When the form is being filled, a user can press 
F1 to view this information. This facility could be useful when field contents are complex, for 
example in the case of tax forms; you could use this facility to explain the meaning of a field 
and the possible consequences of certain responses.
To enter help information
1 Select the field that you want to set up
2 Select Data Properties (Edit menu). Note that this option is also present on the menu 

displayed when you click the right mouse button. This will display the Field data 
properties dialog.

3 Click the Help tab to display the Help window in the dialog.
4 Enter the help text then click the OK button.



Fixing the input format
You can fix the format of text entered into a field, so that the user cannot change the 
appearance of entries in the Filler.
To fix the format
1 Select the field that you want to set up
2 Select Data Properties (Edit menu). Note that this option is also present on the menu 

displayed when you click the right mouse button. This will display the Field data 
properties dialog.

3 Click the Format tab to display the Format window in the dialog.
4 Ensure that the checkbox is deselected.



Final checks on your form
You can perform final checks on your form by:

 Checking spelling
 Using the thesaurus



Checking spelling
You can check the spelling of either the whole form or selected text, in both the Designer 
and the Filler. OfficeForms maintains a dictionary that is used whenever you perform a 
spelling check.

 Using the spellchecker
    Adding a word to your dictionary



To use the spellchecker
1 If you want to check the spelling of only a selected part of your form, select the required 

text. If you do not select any text, you will only be able to perform a check on the whole 
form.

2 Select Spellcheck (Tools menu).
3 From the displayed sub-menu, select either All Text or Selected Text. If you did not select 

any text in step 1, the Selected Text option will be greyed. The spelling check will begin as
soon as you make a selection.

4 If any unrecognised words are detected, a Spelling Check dialog will be displayed showing
the detected word and any suggested corrections. Take the appropriate action in response
to any messages in this dialog.

5 When the spelling check is complete, a message box will be displayed showing how many
words have been checked. Click the OK button.



To add a word to your dictionary
1 Type the word in a text field on your form.
2 Select the text field.
3 Select Spellcheck (Tools menu).
4 From the displayed sub-menu, choose Selected Text. If the word is not already in your 

dictionary, a Spelling Check dialog will be displayed showing the word and any suggested 
corrections.

5 Click the Add to Dict. button.
When you add words to the dictionary they are stored in a dedicated file , named userdict.lex, in the 
same folder or directory as your OfficeForms program. You cannot edit this file, but you can delete or 
rename it. If you do this, the next addition will start a new file with the name userdict.lex.



Spelling Check dialog
The following illustration shows the Spelling Check dialog. Click areas of the dialog to see a 
description of what they do.



Word is misspelt area
This area shows any unrecognised word.



Suggestions area
This area lists similar words to the unrecognised word. The suggestions are taken from your 
dictionary.



Replace button
Click this to replace the unrecognised word with the highlighted suggestion.



Ignore button
Click this to ignore this occurrence of the unrecognised word.



Add to Dict. button
Click this to add the unrecognised word to your dictionary.



Using the thesaurus
OfficeForms has its own thesaurus that you can use to avoid repetition and ensure the most 
accurate phrasing of text on your form.
To use the thesaurus
1 Select the word that you want to look up in the thesaurus.
2 Select Thesaurus (Tools menu). The Look Up dialog will be displayed, containing the word 

you selected.
3 If you want to use one of the suggested synonyms, select it from the list and click the 

Insert In Doc button. The suggestion will replace the selected word.
4 If you want to look up further synonyms related to one of the suggestions, select the 

suggestion and click the Look Up button.
5 When you have finished using the thesaurus, click the Exit button.



Look Up dialog
The following illustration shows the Look Up dialog. Click areas of the dialog to see a 
description of what they do.



Exit button
Click this to close the dialog.



Word area
This area shows the word currently selected.



Synonyms area
This area shows a selection of words with similar meanings to the one in the Word area. 
Double-clicking an entry will place it in the Word area.



Look Up button
Click this to see a selection of synonyms for the word in the Word area.



Insert In Doc button
Click this to replace the selected word in the form with that in the Word area.



Using OfficeForms with databases
Database operations within OfficeForms are:

Setting up a database
Maintaining database links
Using calculations with a database
Storing pictures in a database
Links to non-OfficeForms databases
Using the Filler with a database
Validation, calculations and databases
Copying forms and databases



Setting up a database
OfficeForms contains a wizard that you can use to set up a Microsoft Access compatible 
database for your form. This will allow you to maintain a two-way link between the database 
and your form to store, edit and retrieve information whenever you need..

 Setting up an Access database



To set up an Access database
1 Open the form in the Designer.
2 Select Database Wizards (Tools menu). This will display the Link Manager dialog.
3 Click the Create Connection button. This will display the Create Connection dialog.
4 Select the radio button labelled Create an Access database to hold your form data.
5 Click the OK button. This will display the Enter a filename for the database dialog 

prompting you to enter file and connection names for the link.
6 Enter the folder or directory and filename for the database. The default extension is

.MDB, and we recommend that you should always use this.
7 Enter a unique name for the database connection.
8 Click the Finish button to create the database. The Link Manager dialog will be displayed

showing the new connection.



Link Manager dialog
The following illustration shows the Link Manager dialog. Click areas of the dialog to see a 
description of what they do.



Database Connections area
This shows the names of all connections from the current form to databases. Connections to 
non-Office databases are shown by the suffix -Link.



Create Connection button
Click this to create a new connection.



Copy Connection button
Click this to make o copy of the selected connection. A chain of dialogs will be presented, 
allowing you to specify the characteristics of the copy.
Note      You can only copy connections with the suffix -Link.



Delete Connection button
Click this to delete the selected connection. You will be asked to confirm the deletion.



Set As Default button
Click this button to set the selected connection as the default for the form. This connection 
will be started whenever the form is opened.



Create Connection dialog
The following illustration shows the Create Connection dialog. Click areas of the dialog to see
a description of what they do.



Create a Microsoft Access Database button
Click this to create a new Access database and link it to your form.



Link the form to an existing ODBC database button
Click this to link the form to a non-Office database.



OK button
Click this to accept the data and selections then display the next dialog in the wizard 
sequence.



Enter a filename dialog
The following illustration shows the Enter a filename for the database dialog. Click areas of 
the dialog to see a description of what they do.



File Name area
You can enter a name for the database file in this area.



Connection Name area
You can enter a unique name for the connection between the form and the database.



Browse button
Click this to display a standard Windows dialog allowing you to enter a folder or directory 
and a filename.



Next button
Click this to accept the data and selections then display the next dialog in the wizard 
sequence.



Indexes area
Four drop-down lists allow you to select fields that will be used as the primary sort fields for 
records in the database.



Back button
Click this to close the dialog and go back to the previous dialog in the sequence. Any entries 
made in this dialog will be lost.



Finish button
Click this to complete the sequence of operations.



Database name
This shows the name of the database that you are creating.



Links to non-OfficeForms databases
You can also link your form to existing ODBC-compliant databases. Drivers for the following 
databases are provided within OfficeForms:

Access.
dBase.
Paradox.
Microsoft SQL Server.

If you want to link to any other database, you must first obtain a suitable driver. All drivers 
must conform to ODBC level 1 and must support keyboard-driven cursors.

 Linking a form to a database



To link a form to a database
1 Open the form in the Designer.
2 Select Database Wizards (Tools menu). This will display the Link Manager dialog.
3 Click the Create Connection button. This will display the Create Connection dialog.
4 Select the radio button labelled Link the form to an existing ODBC database.
5 Click the OK button. This will display the Select source database dialog.
Note    The database you want to use must be an available data source within the Windows Control Panel
32 bit ODBC dialog (for Windows 95 or NT) or the ODBC dialog for Windows 3.1x.

6 Select the data source you want to use, then click the Next button. This will display the 
Connect to the database dialog.

7 Click the Connect button. When the connection is made OfficeForms will check the 
Connected checkbox.

8 Click the Next button. This will display the Select a table from the source dialog showing 
the tables present in the selected data source.

9 Select the database table that is to link with the form, then click Next. This will display 
the Link from fields to database columns dialog in which you can set up the database 
table columns that will receive data from the form.

10 Select a table column in the list, then click the corresponding field in your form (in the 
Designer) to allocate the field to the table column. The name of the field will be shown. 
Repeat this until all of the required fields have been linked to database columns.

Note    You can break a link by selecting the field and clicking the Remove Link button.

11 Click the Next button. This displays the Give this connection a name dialog prompting 
you to enter a name for the link.

12 Enter a name for the connection then click the Finish button. The Link Manager will be 
displayed showing the new connection.



Select source database dialog
The following illustration shows the Select source database dialog. Click areas of the dialog 
to see a description of what they do.



Available Data Sources area
This area shows all of the data sources available for this form. You can select any of these as
the database to store records generated by the form.



Connect to the database dialog
The following illustration shows the Connect to the database dialog. Click areas of the dialog 
to see a description of what they do.



Connect button
Click this to connect the form to the selected database.



Connected checkbox
When OfficeForms has made the connection to the database, it will check this box.



Select a table from the source dialog
The following illustration shows the Select a table form the source dialog. Click areas of the 
dialog to see a description of what they do.



Available Tables area
This area shows all of the tables in the database that can be linked to your form. You can 
select any of these for the link.



Link form fields to database columns dialog
The following illustration shows the Link from fields to database columns dialog. Click areas 
of the dialog to see a description of what they do.



Table columns area
This contains a list of all of the columns in the selected database table. You can assign a 
form field to each by selecting the table column the clicking the field in the Designer. The 
field name will then be shown next to the table column name.



Remove Link button
Click this to remove the link selected in the Table Columns area.



Give this connection a name dialog
The following illustration shows the Give this connection a name dialog. Click areas of the 
dialog to see a description of what they do.



Maintaining database links
You can perform a number of tasks to maintain your database links. These are achieved 
through the Link Manager dialog which you can open by selecting Database Wizards (Tools 
menu). Database link maintenance consists of:

Copying connections
Deleting connections
Setting up a default connection to started 
automatically when the form is opened



To copy a connection
Note    You can only copy connections that link to databases. These are shown in Link Manager with the 
suffix -Link.

1 Select the connection in the Link Manager dialog.
2 Click the Copy Connection button. This will display the Select source database dialog.
Note    The database you want to use must be an available data source within the Windows Control Panel
32 bit ODBC dialog.

3 Select the data source you want to use, then click the Next button. This will display the 
Connect to the database dialog.

4 Click the Connect button. When the connection is made OfficeForms will select the 
Connected checkbox.

5 Click the Next button. This will display the Select a table from the source dialog showing 
the tables present in the selected data source.

6 Select the database table that is to link with the form, then click Next. This will display the
Link form fields to database columns dialog in which you can set up the database table 
columns that will receive data from the form.

7 Select a table column in the list, then click the corresponding field in your form (in the 
Designer) to allocate the field to the table column. The name of the field will be shown. 
Repeat this until all of the required fields have been linked to database columns.

Note    You can break a link by selecting the field and clicking the Remove Link button.

8 Click the Next button. This displays the Give this connection a name dialog.
9 Enter a name for the copy of the connection then click the Finish button. The Link 

Manager will be displayed showing the copy as a new connection



To delete a connection
1 Select the connection in the Link Manager dialog.
2 Click the Delete Connection button. You will be asked to confirm the deletion.
3 Click the Yes button to confirm the deletion.



To set a default connection
1 Select the connection in the Link Manager dialog.
2 Click the Set As Default button. A warning will be issued that this connection will be 

started automatically whenever the form is opened.
3 Click the OK button. The connection will be shown with Default in parentheses after it.



Using the Filler with a database
When a form has been linked to a database, users can connect the Filler to the database 
directly.
If you have not set up a link to a database, OfficeForms sets up a default called the No Database 
Access connection. This holds a single record containing the content of the form when it was last saved in
the Filler.

If you use the No Database Access connection, clicking the Next Record tool from the Control toolbar 
stores the current form content and displays a blank record.

When a form is linked to a database, you can do the following:
Adding records
Sorting records
Searching for records
Navigating through the database
Filtering records
Changing the database connection



Adding records
If the form has a connection to a database, then the message No Records is shown when it is
first opened in the Filler. You can add records with the Filler is in Add mode.
To add records
1 With the form in the Filler, click the Add Mode tool in the Control toolbar.
2 Make entries in the fields of the form.
3 If you want to add further records, click the Next Record tool in the Control toolbar. The 

existing record will be passed to the database and a blank record will be displayed. If you 
want to add a single record to the database, you must still click the Next Record tool to 
save the new record.

4 Repeat steps 2 and 3 until all records have been entered.



Navigating through the database
A set of navigation buttons allow you to move through the records held in the database. 
These are in the Control toolbar, and allow you to:

Display the first record in the database.
Skip ten records backwards.
Display the previous record.
Display the next record.
Skip ten records forwards.
Display the last record in the database.

Sorting records
You can sort the records in the database using any field or the order in which they were 
entered.
To sort records
1 Click the Sort tool in the Control toolbar. This will display the Order dialog.
2 Select the field to be used (or Entry Order).
3 Click the OK button. The records can now be viewed in order of the entries in the selected

field.



Order dialog
The following illustration shows the Order dialog. Click areas of the dialog to see a 
description of what they do.



Available fields area
This area lists all of the fields within your form. You can select the field that will be used to 
sort records. Selecting Entry Order sorts records into the order in which they were entered.



Filtering records
You can select a number of records from the database according to entries in a specified 
field. This can cut down the number of records viewed in large databases, making searches 
and sorts much quicker.
To filter records
1 Select the field that you want to use to filter records.
2 Click the Filter tool in the Control toolbar. This will display the Filter Setup dialog.
3 Select the expression that you want to use and enter values. Use the NOT checkbox to 

invert expressions (for example to change greater than to NOT greater than).
4 If you want the records to be sorted by this field as the records are filtered, select the 

Order results by this field checkbox
5 Click the OK button.



Filter Setup dialog
The following illustration shows the Filter Setup dialog. Click areas of the dialog to see a 
description of what they do.



Field name
This shows the name of the field selected for the filtering process.



Order results by this field checkbox
Select this if you want OfficeForms to sort records by this field as it filters them.



Searching for records
You can search for records according to the contents of a selected field.
To search for records
1 Select the field that you want to use to search for records.
2 Click the Setup search tool on the Control toolbar. This will display the Search setup 

dialog.
3 Enter the starting character string of all the records to be included in the search. This 

could be the first word, or even just the first few characters. If all of the records that you 
want have the same entry in this field, enter the whole entry.

4 Click the Start search button. When the first record meeting the search criteria has been 
found, the selected records will be presented and a small Navigation toolbar will be 
displayed.. You can use the Search Next and Search Previous tools to scroll through the 
records. Select the End Search tool to perform further operations on the database.



Navigation toolbar
The following illustration shows the Navigation toolbar. Click areas of the dialog to see a 
description of what they do.



Search Next tool
Click this to find the next occurrence of the search criteria.



Search Previous tool
Click this to return to the previous occurrence of the search criteria.



End Search tool
Click this to stop the search and close the Navigation toolbar.



Search setup dialog
The following illustration shows the Search setup dialog. Click areas of the dialog to see a 
description of what they do.



Search area
Enter the starting character string of all the records to be included in the search in this area.



Start search button
Click this to begin the search.



Changing the database connection
You can change the connection from the form to the database.
To change the connection
1 Select the Connections tool in the Control toolbar. This will display the Choose a 

connection dialog containing all of the connections defined for the form.
2 Select the connection then click the Connect button. If you want to choose the No 

Database Access option, click the No Access button.



Choose a connection dialog
The following illustration shows the Choose a connection dialog. Click areas of the dialog to 
see a description of what they do.



Connections area
This area shows all of the connections from this form to databases. You can select the new 
connection from this list.



Connect button
Click this to replace the current selection with the one selected in the Connections area.



No Access button
Click this to remove connections from the form to databases.



Using calculations with a database
Your forms may contain fields with associated calculations, and a set of fixed rules control 
how these calculations are handled when the form is linked to a database. This ensures that 
calculations cannot be performed twice for a given field using the same source data.
Writing Data to the Database
When data is passed from your form to a database, any calculations applied to a field are 
honoured. These calculations are performed before the information is added to the 
database.
If you do not want calculation results to be passed to the database, do not link the calculated field in 
the form to the database. To remove this link, open the Field data properties dialog and uncheck the Save
Field Data In Automatic Database checkbox. For more information refer to Fixing the input format.

Reading Data from the Database
When data is passed from the database into a field that has an associated calculation, no 
calculation will be performed. The information from the database is written directly into the 
field and will not be changed.



Validation, calculations and databases
If validation has been specified for a field, the effects of the validation are somewhat 
modified when the form is connected to a database. The rules are:
1 Whenever a new value is typed in to a field, the field will be validated as specified. If it 

fails the validation a message box is shown and you are forced to enter a valid value into 
the field.

2 Calculated values, on the other hand, are not validated immediately after they are 
calculated. This is because a calculated field may go through several different values as 
more detail is entered on to other fields on the form, and only the final value is important 
(for example - if commission is calculated based on quantity of goods and the price per 
item). Only when the whole form is about to be saved - signalled by the user pressing the 
Next Record button - are calculated fields checked against the validation requirements. At
this stage, a warning message box is displayed and you must correct the form before 
being allowed to save its contents.

3 When you are browsing through existing records in a database:
No validation whatsoever is performed - whatever is already in the database is 

assumed to be valid.
Calculated fields are only calculated if they are not linked to columns in the database.

Again, this is because what is already in the database is assumed to take precedence.
Some validation may be additionally imposed by the database itself. For example, if a 
database column is only allowed to hold integer values between 0 and 65386, that limitation
will be imposed on a field which is linked to it in addition to any validation specified by the 
field itself.



Storing pictures in a database
When there is an open connection from the Filler to a database, any images placed in a 
picture field can be saved into the database. Picture fields are highlighted by a dashed line. 
If no image is present, the field contains the message No Image Available.
Note    You can store images in the single saved record if you are using the No Database Access 
connection option.

You can either insert a picture file directly, or use the clipboard to transfer a graphic image 
from another application.

Inserting picture files
 Inserting images using the clipboard
 Removing pictures from picture fields



To insert a picture file
1 In the Filler, select the picture field in the form.
2 Select Picture (Insert menu). A standard windows file selection dialog will be displayed.
3 Select the folder or directory path and choose the picture file to be inserted.
4 Press RETURN. The picture will be imported into the filler and will be displayed in the field.



To insert an image using the clipboard
1 Display the image on your computer screen, opening its host application if necessary.
2 Select the image.
3 Use the appropriate menu selection or keyboard shortcut within the host application to 

copy the image to the clipboard.
4 Make the Filler active and select the field.
5 Select the Paste tool from the Main toolbar. The image will be inserted into the field.



To remove a picture from a picture field
1 In the Filler, select the picture.
2 Press the DEL key. A message box will be displayed asking you to confirm the deletion.
3 Click the OK button.
When pictures are saved within a form, the images will be saved in a separate file to 
optimise file sizes. This file will be placed in the same folder or directory as the database file 
(specified when the database was set up). It will be given the same name as the database, 
but with the suffix .OFI.



Copying forms and databases
You can copy, rename and move both forms and databases. You should remember that if a 
form has been linked to a database, then the form holds the link information between itself 
and the database. Each database can operate under the ownership of only one form, 
although you may be able to access it through links from other forms.
All links between forms and database files, including the graphics files, are maintained by an
ODBC administrator program supplied as part of your computers operating system. This 
independent of both OfficeForms and the database, and checks the connection integrity 
whenever the form is opened. If you want more information about the ODBC manager, open 
it and refer to its on screen help system.

 Copying, moving and renaming forms
Copying, moving and renaming database files



Copying, moving and renaming forms
You can do any of these using the standard operations available through your version of 
Windows. If you perform any of these operations on a form, its database links are 
maintained. As long as the form is kept on the same computer as its database file, the ODBC
manager will ensure that the link integrity is maintained when the form is opened.
If you move the form to a different computer, you must also move all associated database 
and picture files. If the folder or directory structure on the new host computer is not 
identical, the ODBC manager will not be able connect the form to the database when the 
form is opened in the Filler. You will be prompted to select the files and their folder or 
directory so that the link can be made.



Copying, moving and renaming database files
You can do any of these using the standard operations available through your version of 
Windows. Any of these will, however, result in the loss of all connections to any related form.
The ODBC manager will not be able connect the form to the database when the form is 
opened in the Filler. You will be prompted to select the files and their folder or directory so 
that the link can be restored.



Saving forms as executables
You can save your form as an executable at any time, allowing users to fill it in without 
having to purchase a copy of OfficeForms. There are some limitations in the use of 
executable forms.
If you want to e-mail a form as an executable without saving it, you can select Send (File menu) then 
select the Send As Executable option from the sub-menu. You can then enter the name and address of 
the recipient to mail the form directly. For more information refer to OfficeForms and e-mail.

Saving the form as an executable
 Using executable forms
 Limitations of executable forms



To save a form as an executable
1 Select Save as Executable (File menu). This will display a standard Windows Save As 

window containing the default name for the executable (this is the name of the form with 
the extension .EXE).

2 If you want to change the filename for the executable, enter the name you want to use. 
We recommend that you should always use the extension .EXE.

3 Press RETURN. The form will then be saved as an executable.



Using Executable Forms
When a form has been saved as an executable, you can distribute it using diskettes or 
e-mail. Users can install it into any directory or folder, and can run it at any time either from 
diskette or the hard disk.

 Running an executable form
 Facilities available for executable forms



Running an executable form
You can run an executable form in the same way as any executable. Double-clicking the 
forms icon will run it, as will using the Run option (from the File menu in Windows 3.1x 
Program Manager, or the Start menu in Windows 95).
Running the executable will start the Filler containing the form.
Note    Running an executable form gives the Filler one view only. You will not be able to load any other 
form into the Filler, and closing the form will also close the Filler.



Facilities available for executable forms
When you run an executable form, you can fill it in the normal way. You can also fax and e-
mail its content.



Limitations of Executable Forms
As an executable is saved as a stand alone item, there are limitations governing the objects 
and facilities that you can use in the form design. You cannot use any object or function that 
relies on links to external files.
The main limitations are:

The form must not contain any Barcode 
Objects.
There must be no pictures in the form.
The form must have no links to external 
databases.
The user cannot use the spellcheck or 
thesaurus facilities when filling the form.

OfficeForms and e-mail
You can mail your form directly from the Designer to any client with a MAPI-compliant e-mail 
system such as NetScape or Lotus Notes. If you are not sure whether the client system is 
MAPI-compliant, refer to the documentation supplied with the e-mail system.
The first time that you send an e-mail, you may need to select a profile to be used by your 
system. You will be asked to select a profile from a list.

 Mailing forms from the Designer
 Mailing forms from the Filler



To mail a form from the Designer
Note    In the following procedure, the actual steps you need to take after step 1 may depend on the e-
mail system you use.

1 Select Send (File menu). From the displayed sub-menu, select either Send As Form or 
Send As Executable. This will display the EMail Address dialog.

2 Enter the recipients name and e-mail address. If you are mailing the form to another user 
on your own network, you do not need to enter an address.

3 Click the OK button.
The form will be sent as a file attached to an e-mail message. The recipient can then open 
the file in OfficeForms in the usual way. If the form was sent as an executable, the recipient 
can run it directly without needing to open it in OfficeForms.
Note    The recipient must have OfficeForms to use a form sent from the Designer via e-mail. If the 
recipient does not run OfficeForms, you can save the form as an executable as described in Saving 
Forms as Executables then e-mail it using the facilities available in your e-mail system.



The EMail Address dialog
The following illustration shows the EMail Address dialog. Click areas of the dialog to see a 
description of what they do.

There are two ways to use the fields specifying recipient's name and Email address.

1. You can just enter a name, leaving the address blank.    This requires the name to have 
already been set up in your Email address book - for example the address book managed 
by Microsoft Exchange.    The mail will go to the specified name.

2. You can enter both name and address.    This requires the address to be specified a way 
that allows the EMail system to recognise the type of address and route it accordingly.    
This depends on prefixing the address itself with a type specifier such as SMTP: for 
internet addresses and FAX: for fax telephone numbers.    These prefixes are recognised 
by the EMail system as being associated with particular EMail gateways or transport 
services.    

Typically an address formatted like this:
SMTP:bill@minisoft.com

is recognised as an internet address, and providing the Email system has an Internet 
gateway associated with it, will be sent to the address bill@minisoft.com.



Recipient's name area
You can enter the recipients name in this area.



Recipient's address area
You can enter the recipients e-mail address in this area. Note that you do not need to enter 
an address in this field if the recipient is featured in your servers e-mail address book.



Choose From Address Book    or Give Details Now

If you check "Choose From Address Book" the Email system will be brought up to allow the 
recipient to be chosen using its standard facilities.    Otherwise you may specify the recipient 
by entering data into the name and address fields.



Mailing from the Filler
When a form is e-mailed from the Filler, only the form contents are sent. These are held in a 
format that can be read back into the Filler.
The first time that you send an e-mail, you may need to select a profile to be used by your 
system. You will be asked to select a profile from a list.

 Mailing forms directly from the Filler
 Importing mailed forms into the Filler



To mail a form directly from the Filler
Note    In the following procedure, the actual steps you need to take after step 1 may depend on the e-
mail system you use.

1 Select the Send E-mail tool from the Main toolbar. This will display the EMail Address 
dialog.

2 Enter the recipients name and e-mail address. If you are mailing the form to another user 
on your own network, you do not need to enter an address.

3 Click the OK button.
The form will be mailed into the recipients e-mail in-box.
Note    The form may be configured so that the e-mail recipient and address are derived automatically 
from fields within the form. If this is the case, the e-mail will be sent automatically when you select the 
Send E-mail tool. For more information about automatic addressing of e-mails, refer to the examples 
given in Specifying calculations.



Importing a mailed form into the Filler
1 In the Filler, open the form to receive the mailed content.
2 Select the Import E-mail tool from the Main toolbar. This will display a dialog from which 

you can choose the file to be imported.
Note    This dialog shows, by default, all files in your in-tray containing form contents with fields that match
the current form. You can select any mailed form, but you should take great care as there may be conflicts
in field types between the form and the imported file.

The file will be imported, with the contents of fields matched by name to fields in the open 
form. OfficeForms will ignore any fields in the imported file with no corresponding fields in 
the open form and any fields with the same name but of different type.



OfficeForms and Microsoft Office
OfficeForms has been designed to integrate fully with the Microsoft Office suite. Three 
typical applications of this integration are:

 Using the Form Filler inside Word
 Using the Form Designer inside Word
 Using OfficeForms with Access



Using the Form Filler inside Word
One possible application for using the form filler in Word is to embed a form inside a word 
document which allows access to the contents of a database of names and addresses. For 
example, it is possible to place a small form inside a letter to act as a Fax Header. By 
activating the form, the user can locate the desired recipient from a database. Then, all the 
user has to do is to print the document which will be printed with the desired recipient 
details at the head of the letter.

 How to do it



To use the Form Filler inside Word
1 Create the form.

Ideally this should be created with a page size corresponding to the actual space that it 
will occupy in the Word document. In particular, the height of the form would typically be 
no more than 3 or 4 inches.

  Example
2 Create a database from the form.

This is simply a matter of choosing Database Wizards (Tools menu). This brings up the 
Link Manager dialog. Now choose Create Connection. The steps are straight forward - but 
see Using OfficeForms with databases for more information.

3 When the previous stage is finished control will return to the Link Manager. Now set the 
database as the Default Connection by selecting the newly created database in the list 
and pressing Set As Default. By doing this you will ensure that when the form is activated 
inside the Word document - as described below - it will already be connected to the 
database.

4 OK the Link Manager dialog.
5 Save the form.
6 Start Word and either open an existing document or start a new one. Establish where the 

form should go and click at that point to place the caret at the point of insertion.
7 Choose Insert Object from the menu. Then choose Create From File from the resulting 

dialog.
8 Select the file, either by typing in the full path name or by locating it using Browse. Press 

OK, leaving both Link To File and Display As Icon unchecked.
The form will now be inserted into the Word document. It is inserted as an inactive object 
- to use the filling and database access features of the filler it is necessary to activate the 
form.

Note    Word, in common with most OLE client programs, allows OLE objects to be resized while they are 
inactive. The result is to distort any text in the object almost beyond recognition. We strongly recommend 
that you do not do this.

9 Activate the form by double clicking it. This will bring up the filler inside the Word 
document. You can then look through existing records in the database, add records to it 
and change existing records. In fact the in-place active form behaves just like it does 
when opened in the filler. When the form contains the information that you require to 
print with the Word document, click outside the form to deactivate it. You can then print 
the document from Word as usual.



A typical form to be used in Word
The form has been created 6 inches wide - a width that will easily fit within the margins of 
most Word documents, and 2 inches high - the correct height to accommodate the 
information that it is required to present:



Using the Form Designer inside Word
The form designer is not simply a tool for designing forms, it is also a powerful drawing 
package in its own right. Heres how to create a mini-form inside a Word document.
1 Start Word and either begin a new document or open an existing one.

Decide where the form should go and click at that point to place the caret at the point of 
insertion.

2 Choose Insert Object. Leave the dialog on the Create New page and pick OfficeForms 
Document from the Object Type list.

3 The object will appear in the Word document. You can now use the tools and facilities of 
OfficeForms to design your form inside the Word document. To deactivate the form, and 
resume working in Word itself, simply click outside the area occupied by the OfficeForms 
document. To reactivate the form, and alter details of the form you have created, double 
click the form.

The same principle outlined above can be used to insert an OfficeForms form inside any OLE 
client application.



Using OfficeForms with Access
You can use OfficeForms form to view, print and fax information from an Access database.
When OfficeForms is installed, a collection of utilities and drivers is installed alongside it. 
This is the ODBC system which allows software such as OfficeForms to access data from 
many different database systems. 
Since the ODBC system allows access to any data source for which the system has a driver. 
OfficeForms is supplied with drivers for Microsoft Access, Paradox, dBase, FoxPro and SQL 
Server. It is, however, possible to obtain drivers for most common database formats. These 
will often come as part of the package, though sometimes it is necessary to approach the 
database supplier in order to obtain an ODBC driver.
Since a Microsoft Access driver is supplied as part of OfficeForms, it is easy to link a form to 
an Access database. There are three steps in the procedure:

Establishing the database as a registered ODBC
data source

 Establishing a link between OfficeForms and the
data source
Trying the connection



Establishing the database as a registered ODBC data source
1 Bring up the Windows Control Panel and either:

If you are working with Windows 95 or Windows
NT, start up the 32bit ODBC program.
If you are working with Windows 3.1 or 3.11 
bring up the ODBC program.

2 Now click the Add button to add the database to the list of registered data sources.
3 Choose Microsoft Access from the list of drivers.
4 Give the data source a name, then click the Select button to bring up a File Open dialog 

so you can find and select the database you wish to access.
When this dialog is OKd the selected Access database should be registered as an ODBC 
source.



Establishing a link between OfficeForms and the data source
In the Form Designer, open the form you wish to use to act as a Window on to the database.
1 Select Database Wizards (Tools menu).
2 Select Create Connection from the resulting Link Manager dialog.
3 In the Create Connection dialog choose Link The Form To An Existing ODBC Database.
4 Follow though the resulting series of wizard dialogs as follows:

Select the source database. 
The dialog will display a list of registered data 
sources. You should simply highlight the one 
that you have established as the desired data 
source and then press Next.
Connect to the database.
This invokes the ODBC drivers connection 
function, so the actual procedure depends on 
the driver itself, and the nature of the 
database. You may be asked to supply security 
information such as a password before going 
any further. Once a connection has been 
established (signified by a tick in the Connected
checkbox) press Next.
Select a table from the source.
A database typically consist of many Tables of 
information. A table is a structured set of data 
organised into rows, also known as records. 
Each record consists of a number of data items,
where each set of items - or columns - is the 
same for each row. For example each row in a 
personnel database may have columns for 
name, age and address. a form can only access
one table at a time, this dialog you to identify 
the particular table you wish to access. Having 
done so press Next.
Link form fields to database columns.
Fields on the form are used to view particular 
columns when a row of data from the table is 
retrieved from the database by OfficeForms. 
This dialog establishes the links between fields 
on the form and columns in the database table.
To establish a link - select the column from the 
dialog list and then click the corresponding field
in the form. It is not necessary to establish links
for all columns or all fields. Just create links for 
the columns that you wish to access using the 
form.
Having done so press Next.
Finally a unique name needs to be given to this 
connection between the form and this 
particular data source. Many such connections 
can be created for a form, and it is these names
which are used to refer to particular 
connections.



Control now returns to the Link Manager dialog.
If you wish, you can establish the new link as the Default Connection. This is done by 
pressing the Set As Default button. Doing so means that, when the form is opened in the 
filler, the database table will automatically be opened at the same time.



Trying the connection
Open the form in the Form Filler. What happens now depends on how the connections have 
been set up:

If the table has been established as the default 
source, the database will be opened and the 
first record in the date table is used to initialise 
fields in the form.
If no default connection exists, the Connection 
dialog is displayed an the connection may be 
chosen from the list.
If another connection is default, press the 
Connection button. The Connection dialog is 
displayed an the connection may be chosen 
from the list.

Calculation reference
This reference gives you the information you need to implement calculations in your form 
fields.

 Evaluation order of operators
 Using functions
 Alphabetical list of functions



Evaluation order of operators
When you type in a formula the operators are evaluated in order according to normal 
algebraic conventions. Firstly operators are evaluated left to right and according to 
precedence. For example the formula:
+ 8 * 10 - 3
evaluates to 77 (i.e. 80 - 3) not to 56 (i.e. not to 8 * 7). This is because the operator * for 
multiply takes precedence over the minus - operator. The operator with the highest 
precedence is always evaluated first.
You can overrule the normal precedence rules using brackets (). For example, bracketing the 
above expression:
+ 8 * (10 - 3)
causes it to evaluate to 56 (i.e. 8 * 7). What happens is that parts of the expression which 
are enclosed in brackets are evaluated first. You can also nest brackets inside each other, for
example:
+ 8 * (10 - 3 * (7 - 5))
This is more complicated but you can understand what happens here if you work out the 
different parts of the expression one by one starting with the innermost bracket. 
First it becomes:
+ 8 * (10 - 3 * 2)
then the next bracket is evaluated starting with *, which has highest precedence, leaving:
+ 8 * (10 - 6)
followed by the minus - in the bracket, leaving:
+ 8 * 4
so the result is 32.

  Order of precedence for operators



Order of precedence for operators
The precedence order of operators is shown below:
Operator Description
% percent
^ exponential
- unary minus
* and / multiplication and division
+ and - addition and subtraction
& string concatenation
= and <> equal and not equal
< , > , <= and >= less than, greater than, less than or equal and greater than or 
equal
#NOT# logical NOT
#OR# and #AND# logical OR and logical AND



Using functions
To use functions effectively, you need to know about:

General rules for functions
Mathematical functions
Statistical functions
Logical functions
Date functions
Financial functions
Miscellaneous functions
String functions



General rules for functions
Functions can be included in calculations in fields.
Functions are like equations. Functions are evaluated to give a result, usually a number.
For example the formulae:
A1+A2+A3+A4+A5+A6+A7+A8+A9+A10
and
SUM(A1,A2,A3,A4,A5,A6,A7,A8,A9,A10)
are equivalent.
Within a calculation formula you can use more than one function or combine functions with 
other operands, for example:
=SUM(Field_1,Fields_2) + 25
=SUM(Field_1,Field_2) - SUM(Field_3,Field_4,Field_7)
= SUM(Field_1,Field_2) * Vat_rate
The functions available are summarised in the following subsections.



Date functions
These are:

DATE(Year,Month,Day)
DAY(DateTimeNumber)
MONTH(DateTimeNumber)
YEAR(DateTimeNumber)
TIME(Hours,Minutes,Seconds)
HOUR(DateTimeNumber)
MINUTE(DateTimeNumber)
SECOND(DateTimeNumber)
NOW()

Mathematical functions
These are:

ABS(x) MOD(x,y)
INT(x) ROUND(x,Places)
RAND() PI()
SQRT(x) EXP(x)
LOG(x) LN(x)
SIN(x) COS(x)
TAN(x) ASIN(x)
ACOS(x) ATAN(x)
ATAN2(x-coord,y-coord) DEGREES(x)
RADIANS(x)

Financial functions
These are:

CTERM(Rate,FutureValue,PresentValue)
TERM(Payment,Rate,FutureValue)
RATE(FutureValue,PresentValue,NumberOfPerio
ds)
PMT((PresentValue,Rate,NumberOfPeriods)
FV((Payment,Rate,NumberOfPeriods)
PV((Payment,Rate,NumberOfPeriods)
SLN(Cost,Salvage,Life)
SYD(Cost,Salvage,Life,Period)
DDB(Cost,Salvage,Life,Period)

Statistical functions
These are:



SUM(Range_1,Range_2,...)
AVG(Range_1,Range_2,...)
STD(Range_1,Range_2,...)
VAR(Range_1,Range_2,...)
MAX(Range_1,Range_2,...)
MIN(Range_1,Range_2,...)

Note    In the above functions Range represents either a field or a range of cells in a table - for example 
Cost[1..9].



Miscellaneous functions
These are:

CHOOSE(Number,Option0,Option1,...)
ERR()

Logical functions
These are:

IF(Condition,TrueValue,FalseValue)
TRUE()
FALSE()
ISERR(x)

String functions
There is one string function:

CONCATENATE (Field_1,Field2,…)

Alphabetical list of functions

ABS(x)
ABS gives the absolute (i.e. positive) value of x.

  Examples

ACOS(x)
ACOS gives the arc cosine of x. The result is the angle whose cosine is x, in radians. X must 
be between -1 and +1. The result is between zero and pi.

  Examples

ASIN(x)
ASIN gives the arc sine of x. The result is the angle whose sine is x, in radians. X must be 
between -1 and 1.

  Examples
 More

Alphabetical list of functions (continued)

ATAN(x)
ATAN gives the arc tangent of x. The result is the angle whose tangent is x, in radians.

  Examples

ATAN2(x-coord,y-coord)
ATAN2 gives the arc tangent of an angle. The angle is defined by the point x-coord,y-coord. 



The result is the angle in radians whose tangent is y-coord/x-coord. The result will be 
between -pi and pi, with the quadrant chosen appropriately.

Examples

AVG(Field_1,Field_2,...)
AVG gives the average of all the values used as arguments. Each argument, may be a 
number, a field, or a range of cells. Individual fields containing text or being blank are 
treated as though they contained 0.

 More

Alphabetical list of functions (continued)

CHOOSE(Number,Option0,Option1,...)
Choose selects one of the options depending on the number. So if the number is 0 the first 
option is selected, if the number is 1 the second option is selected. Options can be numbers,
text strings and fields. All options supplied must be the same type. If the number is negative
or too big for the list it returns ERR. 

Examples

COS(x)
COS gives the cosine of x where x is the angle in radians.

  Examples
See also SIN and TAN.

 More

Alphabetical list of functions (continued)

CTERM(Rate,FutureValue,PresentValue)
CTERM calculates the number of time periods required for an investment of PresentValue to 
grow to FutureValue whilst earning interest at Rate per compounding period.
Rate is a numeric value giving the interest rate per compounding period.
FutureValue is a numeric value giving the value the investment will grow to at some 
period.
PresentValue is a numeric value giving the present value of the investment.

  Examples
 More

Alphabetical list of functions (continued)

DATE(Year,Month,Day)
DATE returns the DateTimeNumber for the date specified by Year, Month and Day. It works 
with dates from 1st January 1900 up to 31st December 2078 returning a DateTimeNumber 
between 2 and 65380. So 1st January 1900 is 2, 2nd January 1900 is 3, 3rd January 1900 is 4
and so on.



Year is a number between 0 (1900) and 178 (2078).
Month is a number between 1 and 12
Day is a number from 1 to 28,29,30 or 31 depending on the month.
The DateTimeNumber is used in calculations, for example, to find the difference in days 
between two dates.
However you have dates displayed you can still do arithmetic on them because they are 
held internally as DateTimeNumbers.

  Example
See also DAY, MONTH and YEAR.

 More

Alphabetical list of functions (continued)

DAY(DateTimeNumber)
DAY returns the number for the day of the specified date. It works with dates from 1st 
January 1900 up to 31st December 2078 using a DateTimeNumber between 2 and 65380. So
1st January 1900 is 2, 2nd January 1900 is 3, 3rd January 1900 is 4 and so on. Because dates
are held internally as DateTimeNumbers you can also supply it with a date as the argument.

  Examples
See also DATE, MONTH and YEAR.

 More

Alphabetical list of functions (continued)

DDB(Cost,Salvage,Life,Period)
DDB determines the amount of depreciation of an asset in a specified period using the 
double declining balance method. Depreciation is highest in the first periods and reduces 
sharply in subsequent periods. (Indeed it may be nothing for some assets for the last 
period(s)).
Cost is the amount you paid for the asset.
Salvage is the amount you expect the asset to be worth at the end of its Life.
Life is the expected useful life of an asset. This is a whole number usually in years.
Period is a whole number giving the time period for which you want to determine the 
amount of depreciation. For example, if Period is 5 and you expressed Life in years it is the 
depreciation during the fifth year.
The formula is(Cost - Total depreciation from prior periods) * 2 / Life
The Salvage value is used to limit the depreciation in the final years.

  Examples
See also SLN.

 More

Alphabetical list of functions (continued)



DEGREES(x)
DEGREES converts a value x, supplied in radians, into degrees.

Examples

ERR()
ERR() gives the error value ERR. You can use it to bring attention to error conditions in 
conjunction with the IF function.

  Example
See also IF .

EXP(x)
EXP gives ex where e is the mathematical constant 2.718..., the base value of natural 
logarithms.

  Examples
See also LN.

 More

Alphabetical list of functions (continued)

FALSE()
FALSE returns the logical value 0 which is FALSE. This may sound like a tautology until you 
realise that its main use is to make IF more easy to understand.

  Example
See also IF and TRUE().

FV((Payment,Rate,NumberOfPeriods)
FV returns the future value of an ordinary annuity when a regular Payment is invested at a 
fixed interest rate of Rate per period over several periods NumberOfPeriods. It assumes that 
the payments are invested at the end of each period.
It uses the formula:
Future Value = Payment x ((1 + Rate)NumberOfPeriods - 1) / Rate

  Example
If you want to consider the effects of making the payments at the beginning of the periods 
then you need to multiply the result by (1 + Rate).

Example
 More

Alphabetical list of functions (continued)

IF(Condition,TrueValue,FalseValue)
IF evaluates the Condition then gives either TrueValue, if the condition is true or False Value 
if the condition is false.



The Condition can be any expression which can evaluate to true or false e.g. Items > 10, 
Field_1 = 3.
In addition to the arithmetic operators you can use the following comparison and 
combination operators together with bracketing:
= and <> equal and not equal
< and > and <= and >= less than and greater than and
less than or equal and
greater than or equal
#NOT# logical NOT
#OR# and #AND# logical OR and logical AND.

  Examples
 More

Alphabetical list of functions (continued)

INT(x)
INT drops the fractional part of the number X and returns only the integer part. This is not 
the same as rounding a number.

  Examples

ISERR(x)
ISERR can be used to check the contents of a field for the error ERR. X can be a field name. If
x contains ERR a value of 1 (true) is returned otherwise it's 0 (false).
ISERR is particularly useful when you have complex interrelations between the fields 
specified in the calculations.
For example if Average_cost = Total-cost/No_of_Items then when No_of_items is 0 this will 
result in ERR.
Normally further calculations which use Average_cost would also display ERR.
By setting:
Average_cost = IF(ISERR(Total_cost/No_of_items),0,Total_Cost/No_of-Items)
then Average cost displays 0 when there is no No_of _items.

 More



Alphabetical list of functions (continued)

LN(x)
LN returns the natural logarithm of x. Natural logarithms use the mathematical constant e as
a base. X must be a number greater than 0.

  Examples
See also EXP.

LOG(x)
LOG returns the base 10 logarithm of X. X must be a number greater than 0.

  Examples

MAX(Field_1,Field_2,...)
MAX returns the largest of the fields and numbers supplied to it as arguments. Blanks are 
treated as 0.
See also MIN.

 More

Alphabetical list of functions (continued)

MIN(Field_1,Field_2,...)
MIN returns the smallest of the fields and numbers supplied to it as arguments. Blanks are 
treated as 0.
See also MAX.

MOD(x,y)
MOD divides x by y and returns the remainder. X can be any number and y can be any 
number other than 0 (you cannot divide by 0). The resulting remainder is positive if x is 
positive and negative if x is negative.

  Examples
 More

Alphabetical list of functions (continued)

MONTH(DateTimeNumber)
MONTH returns the number for the month of the specified date. It works with dates from 1st 
January 1900 up to 31st December 2078 using a DateTimeNumber between 1 and 65380. So
1st January 1900 is 2, 2nd January 1900 is 3, 3rd January 1900 is 4 and so on. Because dates
are held internally as DateTimeNumbers you can also supply it with a date as the argument.

  Examples
See also DATE, DAY and YEAR.



NOW()
NOW() returns the number which corresponds to the current date and time as reported by 
the computers built in clock. This is a DateTimeNumber. You can display the date by 
ensuring that the type of the field is set to one of the date formats. If you don't choose a 
date type for the field you will just see a number in it.
Note    Do not use this function to calculate the date if you want this date to be permanently save with the 
form data. This is because the function will potentially be recalculated every time the form is opened. 
Instead, use the Insert Date/Time function to insert the date into the current field.

  Examples
See also DATE, DAY, MONTH, YEAR.

 More

Alphabetical list of functions (continued)

PI()
PI() returns the mathematical constant 3.1415...., which is an approximation of the value of 
pi.

  Example

PMT((Principal,Rate,NumberOfPeriods)
PMT returns the periodic payments required to service a loan of Principal amount at Rate 
interest rate per period over NumberOfPeriods. The periodic payments are equal amounts 
paid at the end of each equal length period.
Since Rate is the interest rate for a single period, if you have a yearly interest rate and want 
to work with monthly repayments then you will need to divide the yearly interest rate by 12 
and give Rate as the monthly interest rate.
The following formula is used to work out the payments:

Principal * Rate / (1 - (1 + Rate)-NumberOfPeriods)
  Example
 More

Alphabetical list of functions (continued)

PV((Payment,Rate,NumberOfPeriods)
PV returns the present value of an ordinary annuity of equal Payments at interest rate Rate 
per period over NumberOfPeriods. The payments occur at the end of each period.
It uses the following formula:

(Payment * (1 + (1 + Rate)-NumberOfPeriods)/Rate
  Example

RADIANS(x)
RADIANS converts and angle, x, supplied in degrees to radians.

  Examples



RAND()
RAND returns a fractional random number between 0 and 1 (it will never actually be 1). This 
is useful for sampling if you are using the form to carry out simulations. A new random 
number is generated regularly.
If you want random numbers in a different range then multiply up the value returned by 
RAND by the range and add on the lowest number in the required range.

  Examples
 More

Alphabetical list of functions (continued)

RATE(FutureValue,PresentValue,NumberOfPeriods)
RATE returns the fixed interest rate per period needed for an investment of PresentValue to 
grow to FutureValue over NumberOfPeriods.
The following formula is used:

Rate = (FutureValue/PresentValue)(1/NumberOf Periods) - 1
Example

ROUND(x,Places)
ROUND rounds x to the specified number of Places either to the right or left of the decimal 
point.
If Places is 0, x is rounded to a whole number. If Places is positive x is rounded to the 
number of decimal places (i.e. to the right of the decimal point). If Places is negative x is 
rounded to the number of places to the left of the decimal point. For example, if Places is -2 
x is rounded to the nearest hundred.

  Examples

SIN(x)
SIN returns the sine of x. X is an angle in radians.

  Examples
 More

Alphabetical list of functions (continued)

SLN(Cost,Salvage,Life)
SLN returns the amount of depreciation for one period, using the straight line depreciation 
method. Cost is the cost of the asset, Salvage is the value you expect it to have at the end 
of its Life. Life is the time you expect the asset to be in use, usually measured in years.
It uses the following formula:

(Cost - Salvage) / Life
  Example

SQRT(x)
SQRT returns the square root of x. X must be a positive number. If x is negative SQRT returns



ERR.
  Examples

STD(Field_1,Field_2,...)
STD returns the standard deviation of the population of values supplied to it as arguments. 
Standard deviation gives a measure of how much individual values in the population vary 
from the mean value of the population. When standard deviation is small most of the values 
are close to the mean.
See also VAR.

More

Alphabetical list of functions (continued)

SUM(Field_1,Field_2,...)
SUM returns the total of all the numbers supplied to it as arguments. Blank fields are treated
as 0 and fields containing text or pictures cannot be used. Dates, however, can be added 
into numeric totals since they are stored internally as DateTimeNumbers.

SYD(Cost,Salvage,Life,Period)
SYD returns the amount of depreciation for the specified Period, using an accelerated 
depreciation method, where depreciation is highest at the start of the assets life. Cost is the 
cost of the asset, Salvage is the value you expect it to have at the end of its Life. Life is the 
time you expect the asset to be in use, usually measured in years. Period is one of the 
periods in Life.
It uses the following formula:

(Cost - Salvage)(Life-Period+1) / Life(Life+1)/2
  Example

See also DDB.

TAN(x)
TAN returns the tangent of x, where x is an angle measured in radians.

  Example
 More

Alphabetical list of functions (continued)

TERM(Payment,Rate,FutureValue)
Term returns the number of payment periods that it will take for a series of equal Payments 
earning Rate interest per period to grow to an investment of FutureValue.
It uses the formula:

Ln(1 + FutureValue*Rate/Payment) / Ln(1 + Rate)
  Example

TRUE()



TRUE returns the logical value 1 which is TRUE. This may sound like a tautology until you 
realise that its main use is to make IF more easy to understand.

  Example
See also IF  and FALSE.

 More

Alphabetical list of functions (continued)

VAR(Field_1,Field_2,...)
VAR is a statistical function which returns the variance of the population of values supplied 
to it.
See also STD.

YEAR(DateTimeNumber)
YEAR returns the number for the year of the specified date. It works with dates from 1st 
January 1900 up to 31st December 2078 using a DateTimeNumber between 2 and 65380. So
1st January 1900 is 2, 2nd January 1900 is 3, 3rd January 1900 is 4 and so on. Since dates 
are held internally as DateTimeNumbers you can also supply it with a date as the argument.

xxxYE
AR_DateTi
meNumb
er_examp
les 

Examples

See also DATE, DAY and MONTH.



ABS(x) examples
ABS(12) = 12
ABS(-12) = 12
ABS(0) = 0



ACOS(x) examples
ACOS(1) = 0
ACOS(0.5) = 1.047 (PI()/3 radians)
ACOS(0.5) * 180 / PI() = 60 degrees
ACOS(ABS(Field_3)) = arc cosine of absolute value of Field_3



ASIN(x) examples
ASIN(1) = 1.571 (PI()/2 radians)
ASIN(-0.5) = -0.524 (-PI()/6 radians)
ASIN(-0.5) * 180 / PI() = -30 degrees



ATAN(x) examples
ATAN(1) = 0.785 (PI()/4 radians)
ATAN(1) * 180 / PI() = 45 degrees



ATAN2(x-coord,y-coord) examples
ATAN2(1,1) = 0.785 (PI()/4 radians)
ATAN2(1,1) * 180 / PI() = 45 degrees



CHOOSE(Number,Option0,Option1,...) examples
CHOOSE(0,100,200) = 100
CHOOSE(1,"Sue","Pete","Harry") = Pete
If Field_1 contains 2 then:

CHOOSE(Field_1,1,2,3) = 3
CHOOSE(Field_1,B1,B2,B3,B4) = value in field B3



COS(x) examples
COS(2.31) = -.674
COS(PI()) = -1



CTERM(Rate,FutureValue,PresentValue) examples
CTERM(5%,5000,2000) = 18.78
CTERM(0.05,5000,2000) = 18.78



DATE(Year,Month,Day) example
DATE(10,12,30) = 4017



DAY(DateTimeNumber) examples
DAY(4017) = 30
If Field_1 holds the date 30/12/1910 then:
DAY(Field_1) = 30
If Field_2 is 27/2/1911 then:
=DAY(Field_2) = 27



DDB(Cost,Salvage,Life,Period) examples
DDB(10000,3000,5,1) = 4000
DDB(10000,3000,5,2) = 2400
DDB(10000,3000,5,3) = 600 (reaches Salvage value)
DDB(10000,3000,5,4) = 0
DDB(10000,3000,5,5) = 0



DEGREES(x) examples
DEGREES(PI()) = 180
DEGREES(ASIN(1)) = 90



ERR() example
IF(Field_1 > Field_2,ERR(),0)
will display !err! in the field if Field_1 > Field_2



EXP(x) examples
EXP(1) = 2.718 i.e. e itself
EXP(2) = 7.389



FALSE() example
IF(Field_1 > 100,TRUE(),FALSE())
This is equivalent to, but more readable than:
IF(Field_1 > 100,1,0)
both give 1 if Field_1 > 100 and 0 if Field_1 <= 100



FV((Payment,Rate,NumberOfPeriods) example 1
£10 per annum at 10% for 2 years is
FV(10,10%,2) = 21



FV((Payment,Rate,NumberOfPeriods) example 2
£10 invested at the start of each year at 10% for 2 years:
FV(10,10%,2) * (1 + 10%) = 23.10



IF(Condition,TrueValue,FalseValue) examples
IF(Field_1 = 5,10,20) returns 10 if Field_1 is 5, otherwise 20
IF(Amount < 100 #AND# Credcode = 5,"Good","Bad") returns "Good" only if Amount is less 
than 100 and Credcode is 5, otherwise it returns "Bad".



INT(x) examples
INT(2.34) = 2
INT(5.9) = 5
INT(-22.5) = -23



LN(x) examples
LN(16)/LN(2) = 4
LN(EXP(3)) = 3
If Field_11 contains e, i.e. 2.718... :
LN(Field_11) = 1



LOG(x) examples
LOG(100) = 2
LOG(10^57.1) = 57.1
If A1 contains 10:
LOG(A1) = 1



MOD(x,y) examples
MOD(25,5) = 0
MOD(4,3) = 1
MOD(-4,3) = -1
MOD(-15,-4) = -3



MONTH(DateTimeNumber) examples
MONTH(4017) = 12
If Field_1 holds the date 30/12/1910 then:
MONTH(Field_1) = 12
If Field_2 is 27/2/1911 then:
=MONTH(Field_2) = 2



NOW() examples
If the date is 16/3/92:
NOW() = 33679
INT(NOW()) = 33679
DAY(NOW()) = 16



PI() example
To find the circumference of a circle with diameter 15 inches:
PI() * 15 = 47.12 inches



PMT((Principal,Rate,NumberOfPeriods) example
Suppose you are going to borrow £5,000 to buy a boat at 14% interest per year, paying off 
the amount over 2 years with 24 monthly payments:
PMT(5000,14%/12,24) = £240.07 payment amount per month



PV((Payment,Rate,NumberOfPeriods) example
Suppose one of your pension plans has matured and you have the choice of taking a 
£50,000 lump sum now or receiving payments of £7,000 per annum for the next 15 years. 
You think that inflation will be 5% over the next 15 years. You can work out the present value
of the £7,000 annuity with PV:
PV(7000,5%,15) = £72,657



RADIANS(x) examples
RADIANS(180) = 3.14159 i.e. pi.
SIN(RADIANS(90)) = 1



RAND() examples
To get random numbers between 1 and 10:
1 + RAND() * 9
To get whole random numbers between 100 and 1,000:
INT(100 + RAND() * 900)



RATE(FutureValue,PresentValue,NumberOfPeriods) example
You have bought a valuable antique for £10,000 and expect that it will be worth £15,000 in 5
years time. What is the rate of return on your investment:
RATE(15000,10000,5) = 8.45%



ROUND(x,Places) examples
ROUND(13.457,2) = 13.46
ROUND(22.35,1) = 22.4
ROUND(22.34,1) = 22.3
ROUND(146.78,0) = 147
ROUND(453,-1) = 450



SIN(x) examples
SIN(30 * PI()/180) = 0.5
SIN(1.57) = 1



SLN(Cost,Salvage,Life) example
You buy a car for £15,000 which you expect to last for 6 years and then sell for £4,500. SLN 
can be used to find the straight line depreciation:
SLN(15000,4500,6) = £1,750



SQRT(x) examples
SQRT(4) = 2
SQRT(9) = 3



SYD(Cost,Salvage,Life,Period) examples
You buy a car for £12,000 which you expect to last for 5 years and then sell for £1,000. SYD 
can be used to find the depreciation for the second year and third year:
SYD(12000,1000,5,2) = £2,933
SYD(12000,1000,5,3) = £2,200



TAN(x) example
TAN(PI()/4) = 1



TERM(Payment,Rate,FutureValue) example
Suppose that at the end of every year you put aside £1000 into a savings account which 
earns interest at a fixed 9.5% per annum. TERM can tell you how many years it will take to 
save £10,000:
TERM(1000,9.5%,10000) = 7.35 i.e. 8 years



TRUE() example
IF(Field_1 > 100,TRUE(),FALSE())
This is equivalent to, but more readable than:
IF(Field_1 > 100,1,0)
both return 1 if Field_1 > 100 and 0 if Field_1 <= 100



YEAR(DateTimeNumber) examples
YEAR(4017) = 10
If Field_1 holds the date 30/12/1910 then:
YEAR(Field_1) = 10
If Field_2 is 27/2/1911 then:
=YEAR(Field_2) = 11



ODBC Errors
This section describes things that can go wrong when using Forms with databases - both 
automatically    created ones, and when linking to foreign databases.

There are two types of error that you might see.    

1. If the program detects that an ODBC error has occurred, it will display the ODBC Error 
Dialog.:
This tells you the ODBC error code and the statement (if any) that prompted this error

2. Error messages are sometimes shown by the Administrator and Drivers you use.    They 
will typically be a message box containing a small message and an OK button.    Click for 
example.

When Forms creates an automatic table, or links to an existing database, then connection 
between the form and the data is through an ODBC Data Source. This is maintained by the 
ODBC Administrator, found in the Control Panel.

See:
Common Errors



Common Errors
1. If the data source is removed from the list that the Administrator maintains, then when 

Forms tries to connect to that source, you will get an ODBC error, code IM0002.    
To correct the problem, the data source must be restored.

See: Setting Up A Database.

2. The Automatic databases created by Forms use a particular file to store there data.    This 
file is an Access database file (xxxxxxxx.mdb) and is specified when you first create a 
connection.    If that file is deleted or moved, then you will get an Administrator error 
"Cannot find file '|'".      To correct the problem, the file must be either restored to its 
original location, or the data source reconfigured (with the Administrator) to specify where
the file now is.

3. If a data source is not multi-user (as is the case for Forms' Automatic databases), and it is 
already in use,    then you will get errors when trying to connect to that source.    
Typically, the ODBC Driver will prompt you for a login name and password.    Forms 
Automatic databases will provide "Admin" as a login name.    You will not be allowed to 
login to the source, and after the Driver has finished, Forms will tell you that it failed to 
connect to the data source.

4. Automatic databases also have a second file for storing images.    This will start in the 
same place as the Access file, with extension .ofi.    If this file should be moved or deleted,
you will be prompted by Forms to find it.    If it is not found, then no picture services will be
available when filling the form.



ODBC Error Dialog

This tells you the ODBC error code and the statement (if any) that prompted this 
error



Example Of Driver Error Message

 




